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Preface

This documentation is organized under the following headings:

Using Natural for Ajax

About the Natural for Ajax
Documentation

What is covered in this documentation?

Introduction

What is Natural for Ajax?

System Requirements

Supported operating systems, application servers and web
containers, browsers, and other prerequisites.

Installation

How to install Natural for Ajax on the supported application
servers and web containers.

Setting Up Your Environment

How to make specific definitions in your environment.

First Steps

How to create a “Hello World!” application.

First Steps Responsive Pages

How to build a responsive application.

First Steps Java Pages

How to build a “Hello World” application with Natural for Ajax,
based on Java.

Vii




viii
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

Product Training

You can find helpful product training material on our Learning Portal at https://learn.software-

ag.com.

Tech Community

You can collaborate with Software GmbH experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:
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About this Documentation

Browse through our vast knowledge base.

Ask questions and find answers in our discussion forums.

Get the latest Software GmbH news and announcements.

® Explore our communities.

® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software GmbH resources.

Product Support

Support for Software GmbH products is provided to licensed customers via our Empower Portal
at https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

Natural for Ajax 3
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2 About the Natural for Ajax Documentation

This documentation explains how to create rich internet applications which use the Ajax (Asyn-
chronous JavaScript and XML) technology.

] Note: This documentation describes the Application Designer controls that are mapped to

Natural and are verified for the use with Natural. Application Designer controls that are
not contained here have either no mapping to Natural or their usability with Natural is not
verified.

If you want to develop your own custom controls, see Natural Custom Controls and Java Custom
Controls.

See also Configuration and Administration. There, you can learn how to

start a Natural application from the logon page or with a URL,
manage the configuration file for the session using the configuration tool,
modify the style sheet which controls the font, the color and the representation of the PF keys,

activate the preconfigured security settings of Natural for Ajax and adapt them to your require-
ments,

create your own trust files for a secure connection between the Natural Web I/O Interface server
and Natural for Ajax,

enable logging in the case of problems with Natural for Ajax.
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Introduction

Using Natural for Ajax, you can create rich internet applications using Ajax (Asynchronous
JavaScript and XML) technology.

Natural for Ajax enables Natural users on Windows, Linux and mainframe platforms to develop
and operate Natural applications with a browser-based user experience, similar to GUI desktop
applications.

Adding to flexibility, Natural for Ajax also allows building browser-based user interfaces driven
by Java applications or a mix of Natural and Java.

In contrast to many other tools for building browser-based applications, Natural for Ajax requires
no in-depth knowledge of HTML and/or JavaScript.

Natural for Ajax can convert existing Natural maps to Natural for Ajax pages. Or, just run existing
Natural maps in the browser without conversion.

What is a Rich Internet Application?

Classical HTML- and browser-based applications suffer from known disadvantages: The server's
response time increases with each user interaction, rendering a new page in the browser, thus
discontinuing the user's workflow. In contrast, classical GUI applications suffer from the prerequisite
of installing an application's client component on each client machine.

Rich internet applications based on Ajax technology overcome such disadvantages as they combine
the browser-based application's accessibility with the rich user interface of GUI applications.

Rich Internet Applications with Natural

At runtime, a rich internet application with Natural has the following structure:

® A Natural host session on a Windows, Linux, or mainframe server runs the application code.
Other than with a map application, the application does not deal with user interface issues. It
contains only the application logic and communicates with the user interface layer by sending
and receiving data. The data displays as a page in a web browser. Events, such as button clicks
raised by the user in the web browser, are passed back to the application code. The application
code receives the data modified by the user in the web browser along with such an event. The
event and the data are processed and returned to the web browser page.

® Natural for Ajax, running on an application server, receives data from the Natural application
and merges it into an HTML page, delivered to the web browser. In the inverse direction, Nat-
ural for Ajax forwards events that the user raised in the web browser along with the modified
data to the Natural application.
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" A web browser renders the HTML page. JavaScript code on the page processes local user inter-
action and exchanges data with Natural for Ajax as needed. It uses Ajax technology to exchange
data with the Natural application in the background without re-rendering the complete page.

At development time, creating a rich internet application with Natural proceeds as follows:
® Ajax Developer of NaturalONE is used to develop the user interface layout of a web page and

to bind the controls on the page to data elements in the application.

" When the user saves the page layout, a Natural module of type "Adapter" is generated. The
adapter serves as an interface between the application code and the page layout. It contains:

® adata structure that describes the data that the Natural application has to deliver to the ap-
plication server to populate the web page.

* the Natural code necessary to transfer the data structure to the user interface and to receive
modified data back.

® a code skeleton in the form of comment lines that provide handlers for the expected events.
The application programmer can copy this code skeleton into the main program to implement
the event handlers.

* Then a main program is implemented that exchanges data with the web page using the adapter
and handles the events. The event handler code is not aware of the web page's layout and operates
exclusively on the page data sent and received through the adapter.

* Finally, the navigation between different pages is implemented: A rich internet application
navigates between pages just as a map application would navigate between maps.

Natural Maps in Rich Internet Applications

With the support of Unicode, Natural has introduced the Natural Web I/O Interface that renders
Natural maps in a web browser. Rendering is based on HTML elements. However, rich internet
pages contain much more advanced HTML elements that provide a much better user experience.

When coming from map-oriented applications and planning to switch to rich internet pages, such
projects happen gradually: In certain parts of an application, rich internet pages may replace maps,
and other parts of an application will possibly be left unchanged. To support such gradually

conducted projects, Natural can run "mixed" applications consisting of both, maps as well as rich
internet pages. Seamless navigation between Natural maps and rich internet pages is supported.

Natural for Ajax "
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System Requirements

Supported Operating Systems

The following operating systems are supported:

MMicrosoft Windows 10 Enterprise (LTSC 2021) EOS — until end of support
Microsoft Windows Server 2019 (x64)

Microsoft Windows Server 2022 (64bit)

Microsoft Windows Server 2025 (64bit)

Red Hat Enterprise Linux 9

SUSE Linux Enterprise Server 15

z/OS 3.1

z/OS 2.5

Supported Application Servers and Web Containers

The following application servers are supported. The application servers are not delivered with
Natural for Ajax. They can be obtained from the locations indicated below, according to their re-
spective license terms.

= WildFly 18 and 26 (see http://www.wildfly.org/)

® WildFly 32 (use cisnatural.war from subfolder WildFly]Jakarta)
" JBoss EAP 7

® JBoss EAP 8 (use cisnatural.war from subfolder WildFlyJakarta)
® IBM WebSphere Liberty 21 and 22

® Apache Tomcat 9 and 10 (see http://tomcat.apache.org/)

Supported Web Browsers

Supported browsers in this version are:

Microsoft Edge (Chromium) - current versions
Mozilla Firefox Extended Support Release — current versions
Google Chrome — current versions®”

)

Notes:

@ Only the Extended Support Releases of Mozilla Firefox are explicitly supported. Due to frequent
upgrades of the Mozilla Firefox consumer release, the compatibility of Natural for Ajax with future
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versions of Mozilla Firefox cannot be fully guaranteed. Possible incompatibilities will be removed
during the regular maintenance process of Natural for Ajax.

® Due to frequent version upgrades of Google Chrome, compatibility of Natural for Ajax with
future versions of Google Chrome cannot be fully guaranteed. Possible incompatibilities will be
removed during the regular maintenance process of Natural for Ajax.

& Important: Cookies and JavaScript must be enabled in the browser.

Java

Java 17 and 21.

Natural for Mainframes

If you want to use Natural for Ajax with Natural for Mainframes, the following must be installed:

= Natural for z/OS Version 8.2.5 or above, and

= the Natural Web I/O Interface server.
For detailed information, see:

= the Installation documentation which is provided with Natural for z/OS;

* the section Installing and Configuring the Natural Web I/O Interface Server in the version of the
Natural Web 1/0O Interface documentation, which is provided for Natural for z/OS.

Natural on Linux and Cloud

Natural for Ajax is tested with Natural on Linux and Cloud Version 9.3.3. The Natural Web I/O
Interface server and daemon must be installed.

For detailed information, see:

® the Installation documentation, which is provided for Natural on Linux and Cloud;

" the section Installing and Configuring the Natural Web I/O Interface Server in the version of the
Natural Web 1/0 Interface documentation, which is provided for Natural on Linux and Cloud.
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Natural for Windows

Natural for Ajax is tested with Natural for Windows Version 9.3.3. The Natural Web I/O Interface
server and service must be installed:

For detailed information, see:

® the Installation documentation, which is provided for Natural for Windows;

" the section Installing and Configuring the Natural Web I/O Interface Server in the version of the
Natural Web 1/0O Interface documentation, which is provided for Natural for Windows.

Natural Development Server

Remote development of Natural for Ajax applications requires a supported Natural Development
Server and has been tested with:

® Natural Development Server for Mainframes Version 8.2.5
® Natural Development Server on Linux and Cloud Version 9.3.3

® Natural Development Server for Windows Version 9.3.3

Development Clients

Remote development of Natural for Ajax applications requires a supported NaturalONE version
and has been tested with:

NaturalONE Version 9.3.

License Key File

A valid license key file is required during the installation. The license key file is an XML file which
is usually supplied along with the product. Alternatively, you can obtain a license key file via
your local distributor.
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Installation

Natural for Ajax uses the Installer, which you download from https://empower.softwareag.com/,
to copy the distributables for the supported application servers and web containers to your machine.
You can then install the distributables on your application server or web container as described
in this chapter. On application servers and web containers, Natural for Ajax consists of a web ap-
plication (cisnatural.war).

This chapter provides product-specific instructions for installing Natural for Ajax. It is intended
for use with the Software AG Installer documentation, which explains how to prepare your machine
to use the Installer, and how to use the Installer and Uninstaller to install and uninstall your
products. You can find it at https://documentation.softwareag.com/.

| Note: This chapter does not describe the installation of the additionally required Natural

components on a Windows, Linux or mainframe host, but refers to the corresponding in-
stallation documents.

For important last-minute information, see the readme file that is provided with Natural for Ajax.
You can find it in the Natural for Ajax product documentation at https://documentation.software-
ag.com/.

For information on how to activate the preconfigured security settings of Natural for Ajax and
how to adapt them to your requirements, see Configuring Container-Managed Security in Configuration
and Administration.

You may find additional technical papers dealing with advanced configuration topics in the
Knowledge Center at https://empower.softwareag.com/ (for registered users only).

Installing the Natural for Ajax Distributables with the Installer

This section provides just a brief description on how to install the Natural for Ajax distributables
directly on the target machine using the Installer GUI For detailed information on the Installer,
see the Software AG Installer documentation.

~ To install the Natural for Ajax distributables

1  Start the Installer GUI as described in the Software AG Installer documentation.

2 When the first page of the Installer GUI (the so-called Welcome panel) is shown, choose the
Next button repeatedly (and specify all required information on the shown panels as described
in the Software AG Installer documentation) until the panel containing the product selection
tree appears. This tree lists the products you have licensed and which can be installed on the
operating system of the machine on which you are installing.

3  Toinstall the Natural for Ajax distributables, expand the Natural Products node and select
Natural for Ajax.

4  Choose the Next button.

18 Natural for Ajax
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Installation

Read the license agreement, select the check box to agree to the terms of the license agreement,
and choose the Next button.

On the last panel, review the list of products and items you have selected for installation. If
the list is correct, choose the Next button to start the installation process.

When the Installer has completed the installation, you can find the distributables in the <in-
stall-dir>/Natural Ajax/AppServer directory. You can now install them on your application
server or web container as described below.

Installing Natural for Ajax on WildFly

The distributables for WildFly are contained in the directory <install-dir>Natural Ajax/AppServ-
er/WildFly.

The following is assumed:

" <host> is the name of the machine on which WildFly is installed.

= <port>is the name of the port where WildFly is installed. In a default installation, this is port

8080.

= <adminport>is the name of the port where the Administration Console is installed. In a default

installation, this is port 9990.

" <wildfly_home>is the path to the directory in which WildFly is installed.

The following topics are covered below:

= First-time Installation
= Update Installation

First-time Installation

~ To install Natural for Ajax

1
2

Stop WildFly.

Extract the contents of the file cisnatural.war into a new directory <wi1df1y_home>/standalone/de-
ployments/cisnatural.war.

Add your license file to the directory <wi1df1y_home>/standalone/deployments/cisnatural.war/cis/li-
censekey.

Create a file with the name cisnatural.war.dodeploy in the folder <wi1df1y_home>/standalone/de-
ployments.

Start WildFly.

Natural for Ajax 19
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Update Installation

> To update Natural for Ajax

1 Start WildFly.

2 Create abackup copy of your sessions.xml file, which is located in <wi 1df1y_home>/standalone/de-
ployments/cisnatural.war/WEB-INF.

3 Create a backup copy of your license file, which is located in <wi1df1y_home>/standalone/de-
ployments/cisnatural.war/cis/licensekey.

4  Create backup copies of all modified configuration files, which are located in <wi7d-
f1y_home>/standalone/deployments/cisnatural.war/cis/config.

5  Create backup copies of previously created projects, which are located in <w77d1y_home>/stan-
dalone/deployments/cisnatural.war.

6  Open your web browser and enter the following URL:
http://<host>:<adminport>/console
This opens the Administration Console.

7 Select cisnatural.war in the list of installed applications.

8  Choose Remove.

9  Deploy the cisnatural.war file for the new version of Natural for Ajax as in a first-time install-
ation.

10 Restore the files that you have backed up in steps 2, 3, 4 and 5.

11 Open your web browser and enter the following URL:
http://<host>:<port>/cisnatural/index.html

12 Regenerate the HTML pages.
We recommend using the Ant generation script to regenerate the HTML pages. See Generating
HTML Pages Using the Command Line. Alternatively, you can use the Layout Manager and
Style Sheet Editor tools to manually regenerate the files.
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Installing Natural for Ajax on IBM WebSphere Application Server

The distributables for IBM WebSphere Application Server are contained in the directory <instal7 -
dir>/Natural Ajax/ AppServer/WebSphere.

Natural for Ajax is installed using the Administration Console of IBM WebSphere Application
Server.

The following is assumed:

® <host> is the name of the machine on which the application server is installed.

" <port>isthe name of the port where the application server is installed. In a default installation,
this is port 9080.

® <adminport>is the name of the port where the Administration Console is installed. In a default
installation, this is port 9060.

The following topics are covered below:

= First-time Installation
= Update Installation

First-time Installation

~ To install Natural for Ajax

1 Make sure the application server is running.

2 Open your web browser and enter the following URL:

http://<host>:<adminport>/ibm/console

This opens the Administration Console.
3 Deploy the web application cisnatural.war.
1. Open the tree node Applications > Application Types > WebSphere enterprise applica-
tions.
On the Enterprise applications page, choose Install.
Select WebSphere/cisnatural.war as the path to the new application. Then choose Next.

Choose Next. If additional information is required, you will be prompted.

A

On the Select installation options page, choose Next. You will then install with the default
options.
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6. On the Map modules to servers page, select a cluster and server, select Natural for Ajax
and choose Apply. Then choose Next.

7. On the Map virtual hosts for Web modules page, select a virtual host, select Natural for
Ajax and choose Next.

8. On the Map context roots for Web modules page, enter "cisnatural” as context root and
choose Next.

9. On the Summary page, choose Finish.

10. On the next page, choose Save.

4  Configure the application.
1. Open the tree node Applications > Application Types > WebSphere enterprise applica-
tions.
2. Select cisnatural.war.
3. On the Configuration page, select Class loading and update detection.
4. On the General Properties page, enter a value for Polling interval for updated files (for
example, 300 seconds).
5. On the General Properties page under Class loader order, select Classes loaded with
local class loader first (parent last).
6. On the General Properties page under WAR class loader policy, select Single class loader
for application.
7. Choose OK.
8. On the next page, choose Save.
9. Back on the Enterprise applications page, select cisnatural.war.
10. On the Configuration page under Modules, select Manage Modules.
11. On the Manage Modules page, click the Natural for Ajax link.
12 On the General properties page under Class loader order, select Classes loaded with
local class loader first (parent last).
13. Choose OK.
14. On the next page, choose Save.
5 Deploy the license file.
1. Open the tree node Applications > Application Types > WebSphere enterprise applica-
tions.
2. On the Enterprise applications page, select cisnatural.war and choose Update.
3. On the Preparing for the application update page, choose Replace or add a single file.
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® N o @9

In the Specify the path beginning... field, enter "cisnatural.war/cis/licensekey/<7icensekey -
filename>".

In the Specify the path to the file field, browse for your license key file.
Choose Next.
On the Updating application page, choose OK.

On the next page, choose Save.

6  Start the application.

1.

2.

Open the tree node Applications > Application Types > WebSphere enterprise applica-
tions.

On the Enterprise applications page, select cisnatural.war and choose Start.

Update Installation

~ To update Natural for Ajax

1 Create a backup copy of the Natural for Ajax application and the contained user projects.

1.

Open the tree node Applications > Application Types > WebSphere enterprise applica-
tions.

. On the Enterprise applications page, select cisnatural.war and choose Export. The applic-

ation is exported as the file cisnatural_war.ear.

. On the Export Application EAR files page, choose cisnatural_war.ear to download it from

the application server.

. Extract the web application cisnatural.war from the exported archive.

2 Copy user projects and modified configuration files from the exported old version of cisnatur-
al.war to the new version.

1.
2.
3.

Unpack the exported old cisnatural.war using a zip tool.
Unpack the new cisnatural.war using a zip tool.

Copy the sessions.xml file, which is located in cisnatural.war/WEB-INF, from the old version
to the new version.

. Copy the license file, which is located in cisnatural.war/cis/licensekey, from the old cisnatur-

al.war to the new cisnatural.war.

. Copy all modified configuration files, which are located in cisnatural.war/cis/config, from

the old cisnatural.war to the new cisnatural.war.
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6. Copy all user projects, which are located in cisnatural.war, from the old cisnatural.war to the
new cisnatural.war.

7. Repack the new cisnatural.war to a web application using a zip tool.

3 Uninstall the old version of Natural for Ajax.

1. Open the tree node Applications > Application Types > WebSphere enterprise applica-
tions.
2. On the Enterprise applications page, select cisnatural.war and choose Uninstall.

3. On the Uninstall Application page, choose OK.

4. On the next page, choose Save.

4  Install the new version of Natural for Ajax as in a first installation.

Installing Natural for Ajax on Apache Tomcat

The distributables for Apache Tomcat are contained in the directory <install-dir>/NaturalA-
jax/AppServer/lomcat.

Natural for Ajax is installed using the Tomcat Manager.
The following is assumed:

® <host> is the name or IP address of the machine on which Apache Tomcat is installed.

" <port> is the name of the port where Apache Tomcat is installed. In a default installation, this
is port 8080.

" <tomcat>is the path to the directory in which Apache Tomcat is installed.

| Note: In Apache Tomcat 7 and 8, the Tomcat Manager limits the size of a web application

to be deployed by default to 50MB. Before installing on Apache Tomcat 7 or 8, increase the
values of <max-file-size>and <max-request-size> in the configuration file <tom-
cat>/webapps/manager/WEB-INF/web.xml to at least SOMB.

The following topics are covered below:

= First-time Installation
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= Update Installation

First-time Installation

~ To install Natural for Ajax

1
2

Start Apache Tomcat.

Open your web browser and enter the following URL:
http://<host>:<port>/manager/html

This opens the Tomcat Manager.

Deploy the web application file cisnatural.war:

® Under Select WAR file to upload select the path to the file cisnatural.war.
® Choose Deploy.

Copy the license file into the directory <tomcat>/webapps/cisnatural/cis/licensekey (you have to
create the directory if it does not yet exist).

In the Tomcat Manager, look for the application Natural for Ajax and choose Reload.

Update Installation

~ To update Natural for Ajax

1
2

Shut down Apache Tomcat.

Create a backup copy of your sessions.xml file, which is located in <tomcat>/webapps/cisnatur-
al/WEB-INF.

Create a backup copy of your license file, which is located in <tomca t >/webapps/cisnatural/cis/li-
censekey.

Create backup copies of all modified configuration files, which are located in <tom-
cat>/webapps/cisnatural/cis/config.

Create backup copies of previously created projects, which are located in <tom-
cat>/webapps/cisnatural.

Start Apache Tomcat.

Open your web browser and enter the following URL:

http://<host>:<port>/manager/html

This opens the Tomcat Manager.

Select cisnatural.war in the list of installed applications.
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10
11
12
13
14

15

Choose Undeploy.

Deploy the new version of Natural for Ajax as in a first-time installation.
Shut down Apache Tomcat.

Restore the files that you have backed up in steps 2, 3, 4 and 5.

Start Apache Tomcat.

Open your web browser and enter the following URL:

http://<host>:<port>/cisnatural/index.html

Regenerate the HTML pages.

We recommend using the Ant generation script to regenerate the HTML pages. See Generating
HTML Pages Using the Command Line. Alternatively, you can use the Layout Manager and
Style Sheet Editor tools to manually regenerate the files.

Verifying the Installation

It is assumed that http://<host>:<port>is the URL of your application server or web container.

~ To verify the installation

1  Enter the following URL in your web browser:
http://<host>:<port>/cisnatural/index.html
This opens a page from where you can access the logon page, the development workplace
and the configuration tool.

2 Click on the link for the logon page.
This opens the Natural logon page. The installation is now complete.
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= Setting Up Your Development ENVIFONMENT ... .....ooiiiiiiiiii e
= Setting Up Your Runtime Environment for Natural ..............coooiiiiiiiiii e
= Setting Up the Natural for Ajax Web AppliCation ............oooiiiiiiiii e
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Before you start developing and executing Natural for Ajax applications, you have to make specific
definitions in your environment.

Setting Up Your Development Environment

The recommended development Environment for Natural and Natural for Ajax is NaturalONE.

= Setting Up your Development Environment with NaturalONE
= Setting Up your Development Environment with Natural Studio (deprecated)

Setting Up your Development Environment with NaturalONE

NaturalONE supports the development of both:

Natural programs and Natural for Ajax user interface layouts.
Java programs if you want to use the Natural for Ajax Java support for extensions or layout pages.

For information on how to start with Natural and Natural for Ajax development in NaturalONE
see the Natural ONE documentation, particularly the chapters Using NaturalONE and Ajax Developer.

With NaturalONE, the development of the user interface layouts, does not require anything to be
installed or configured. However ...

The development of Natural programs in Natural Server Mode requires corresponding Natural
Development Servers on your remote machines.

The development of Natural programs in Local Mode requires no additional Natural systems to
be installed or configured.

For more information, see the Natural ONE and Natural documentation.

¢ Tip: Install the Natural for Ajax demos from the Welcome Page of Natural ONE. After in-
stallation, run the program MENU.NSP. Each sample shows a documentation page on
which you see the names of the layout file and the Natural program. You can open the
sample layouts in the Layout Painter editor and edit and debug the Natural code.
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Setting Up your Development Environment with Natural Studio (deprecated)

For practicing remote development with Natural's Single Point of Development (SPoD), a Natural
Development Server must be installed and activated on the remote machine.

Mainframe

When the Natural Development Server runs on a mainframe, see the Natural Development Server
documentation.

Linux

When the Natural Development Server runs on Linux, see Activating the Natural Development
Server on Linux in the Installation documentation provided for Natural on Linux and Cloud.
Windows

When the Natural Development Server runs on Windows, the Web I/O Interface service option,

with setup type Custom, must be selected when installing Natural. See the Installation document-
ation provided for Natural for Windows.

~ To set up Natural Studio

Ask your administrator for the hostname and port number of the Natural Development
Server.

Connect to the Natural Development Server. See Accessing a Remote Development Environment
in the Remote Development Using SPoD documentation provided for Natural for Windows.

Creating a new Natural library for each Application Designer project is recommended.

Setting Up Your Runtime Environment for Natural

Running Natural for Ajax applications outside of NaturalONE in production and/or test environ-
ments requires installation of a Natural server.

Prerequisites:

Mainframe

The Natural Web I/O Interface server must be installed and started. For detailed information,
see Installing and Configuring the Natural Web I/O Interface Server in the Natural Web 1/O Interface
documentation provided for Natural for Mainframes.

Linux

On Linux, the Natural Web I/O Interface server runs as a daemon. This Natural Web I/O Interface
daemon must be installed and activated. For detailed information, see Installing and Configuring

Natural for Ajax 29



Setting Up Your Environment

the Natural Web I/O Interface Server in the Natural Web 1/O Interface documentation provided for
Natural on Linux and Cloud.

" Windows

On Windows, the Natural Web I/O Interface server runs as a service. The Web I/O Interface
service must be installed. See the Installation documentation provided for Natural for Windows.

See also Installing and Configuring the Natural Web 1/O Interface Server in the Natural Web 1/0 In-
terface documentation provided for Natural for Windows.

Setting Up the Natural for Ajax Web Application

The Natural for Ajax Runtime package is a web application archived in a .war file. The basic
cisnatural.war file contains tools for configuration and monitoring and login pages connecting to
remotely running Natural servers.

The cisnatural.war file provides everything for applications based exclusively on Natural Web I/O.

For customized rich internet pages, Natural ONE generates an extended .war file, containing the
Natural for Ajax runtime and the customized rich internet pages. To get started, the basic cisnatur-
al.war file includes a rich internet sample application — the NaturalAjaxDemos.

The setup of the basic cisnatural.war file requires an application server or web container - see the
chapter System Requirements.

Deploy the cisnatural.war file into your application server or web container using the deployment
tools of these servers/containers. See also the chapter Installation.

After the deployment of the cisnatural.war file, you can immediately run the NaturalAjaxDemos
and Natural Web I/O applications. Depending on your Natural environment, you may have to
adapt the default session configuration. To do so, invoke the configuration tool. See Natural for
Ajax Runtime Tools in the Configuration and Administration documentation. Ask your administrator
for the host name and port number of the Natural Web I/O Interface server.

= For Natural for Mainframes
= For Natural on Linux and Cloud
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= For Natural for Windows

For Natural for Mainframes

~ To set up the NaturalAjaxDemos for Natural for Mainframes

1 In the configuration tool, duplicate the Natural for Ajax Example (Windows).

This session starts the Natural for Ajax examples delivered with Natural in the library SY-
SEXNJX. Adapt the settings as follows:

Option Description
Session ID  |Enter the name to be available for selection in the logon page.
Host name

The host name of the Natural Web I/O Interface server. Enter the value that you have
received from your administrator.

Port number

The port number of the Natural Web I/O Interface server. Enter the value that you have
received from your administrator.

Application

Remove the script-name (nwo.bat/nwo.sh).

Options of the Natural for Ajax Examples - Mainframe

2 Press Ok and then Save Configuration.

3  Click Natural for Ajax Login and select your newly created Session ID.

For Natural on Linux and Cloud

~ To set up the NaturalAjaxDemos for Natural on Linux and Cloud

1  Inthe configuration tool, open the Natural for Ajax Example (UNIX). This session starts the
Natural for Ajax examples delivered with Natural in the library SYSEXNJX. Adapt the settings

as follows:

Option Description

Session ID  |Enter the name to be available for selection in the logon page.
Host name

The host name of the Natural Web I/O Interface server. Enter the value that you have
received from your administrator.

Port number

The port number of the Natural Web I/O Interface server. Enter the value that you have

received from your administrator.

Natural for Ajax
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Option

Description

Application

The name of the script that is used to start up Natural sessions. With Natural on Linux
and Cloud a default shell script for starting Natural (nwo.sh) is delivered. See also nwo.sh
- Shell Script for Starting Natural in the Natural Web I/O Interface documentation.

Options of the Natural for Ajax Examples - Linux

2 Press Ok and then Save Configuration.

3 Click Natural for Ajax Login and select your newly created Session ID.

For Natural for Windows

~ To set up the NaturalAjaxDemos for Natural for Windows

1  Inthe configuration tool, open the Natural for Ajax Example (Windows). This session starts
the Natural for Ajax examples delivered with Natural in the library SYSEXNJX. Adapt the
settings as follows:

Option Description
Session ID  |Enter the name to be available for selection in the logon page.
Host name |The host name of the Natural Web I/O Interface server. Enter the value that you have

received from your administrator.

Port number

The port number of the Natural Web I/O Interface server. Enter the value that you have
received from your administrator.

Application

The name of the script that is used to start up Natural sessions. With Natural for Windows
a default batch file for starting Natural (nwo.bat) is delivered. See also Batch File for
Starting Natural in the Natural Web I/O Interface documentation.

Options of the Natural for Ajax Examples - Windows

2 Press Ok and then Save Configuration.

3  Click Natural for Ajax Login and select your newly created Session ID.
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I I First Steps

This part is organized under the following headings:

About this Tutorial

Starting the Development Workplace

Creating a Project

Getting Started with the Layout Painter

Writing the GUI Layout

Setting Up Your Development and Runtime Environment for Natural
Creating the Natural Code

Some Background Information

It is important that you work through the exercises in the same sequence as they appear in this

tutorial. Problems may occur if you skip an exercise.
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7 About this Tutorial

This tutorial provides an introduction to working with Natural for Ajax. It explains how to create
a “Hello World!” application. This covers all basic steps you have to perform when creating pages
with Natural for Ajax: you create a layout file, you create an adapter and a main program, and
you run the application.

When you have completed all steps of this tutorial, the page for your “Hello World!” application
will look as follows:
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(Preview &
‘Hello World! X

Say Hello

Input Area -
Your Marme | |
‘output Area
Result | |

Input your name and press the 'Say Hello' button,

Your application will act in the following way: When you enter a name in the Your Name field
and choose the Say Hello button, the Result field displays "Hello World" and the name you have
entered.

To reach this goal, you will proceed as follows:

1. You will first create a new Application Designer project.

2. You will then use Application Designer's Layout Painter to create the following layout:
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--[m@] natpage
- titlebar (Hello World!)
- header
= button {Say Hello)

-] pagebody

=F2IIitr
++ hdist (100%)
= icon

- rowarea (Input Area)

—Haa2 ifr
A label (Your Name, 100)
[ field (name, 200)
=" rowarea (Output Area)

—H=a2 jfr
A label (Result, 100)
[ field (result, 200)
1 wvdist (100)

=PIl it
A label {Input your name and press the 'Say Hello' button.)
[ statusbar

This corresponds to the following XML layout:

<?xml version="1.0" encoding="UTF-8"7>
<natpage natsource="HELLO-A" natsinglebyte="true" natkcheck="true"
xmins:njx="http://www.softwareag.com/njx/njxMapConverter">
<titlebar name="Hello World!">

</titlebar>

<header withdistance="false">

<pbutton name="Say Hello" method="sayHello">
</button>

<{/header>

<pagebody>

<tr takefullwidth="true">

<hdist width="100%">

</hdist>

<icon image="../cisdemos/images/hello.gif">
</icon>

</itrd>

<rowarea name="Input Area">

Atr>

<Tabel name="Your Name" width="100">
</label>

<field valueprop="name" width="200">
</field>

Natural for Ajax 37



About this Tutorial

</itr>

</rowarea>

<rowarea name="Qutput Area">
<Gtr>

<label name="Result" width="100">
</label>

<field valueprop="result" width="200" displayonly="true">
</field>

</itr>

</rowarea>

<vdist height="100">

</vdist>

<Gtr>

<label name="Input your name and press the &apos;Say Hello&apos; button." <
asplaintext="true">

</label>

</itr>

<{/pagebody>

<statusbar withdistance="false">
<{/statusbar>

</natpage>

3. When you save your layout for the first time, an intelligent HTML page and the Natural adapter
for this page are generated.

4. Before you can start coding, you have to make specific definitions in your development envir-
onment (this tutorial assumes that you are using Natural Studio as your development environ-
ment).

5. You will import the generated Natural adapter into your Natural library.

6. You will then create the main program which will use the adapter to display the page and which
will handle the events that occur on the page, for example, when you choose the Say Hello
button of your application.

You can now proceed with your first exercise: Starting the Development Workplace.
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8 Starting the Development Workplace

This tutorial assumes that you have installed Natural for Ajax as described in the Installation
section.

~ To start the development workplace

1  Make sure that your application server is running.

2 Invoke your browser and enter the following URL:
http://<host>:<port>/cisnatural/index.html

where <host> is the name of the machine on which your application server is installed and
<port>is the port number of your application server.

] Note: If you have not defined another port number during installation, the default port

number is "8080".

3 On the resulting page, click the Development Workplace link.

The development workplace is now shown in your browser.
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'. 3
g Development Workplace

0 OE®E

Application Designer

| Tools & Documentation

=] beveloprnent Toals
=] Project Manager
=] Layouwt Manager
= Style Sheet Editor
[=] Language Manager
m Lizeral Translator
=] war Packager
= contral Editar
=] Manitoring
[ Layout Check
=] Natural Toals
E Map Converter
=] Map Converter Extension AP
E| Conversion Aules
=] Canversion Logs
= {1 Performancs Tools
H Start/Stop Trace
= Execute Trace
— ) Developar Docurments
|:| iInline Documentstion

HTHLBasedEUL

APPLICATION DESIGNER

Lopymght @ 2005 - D008 Softwars AL, Darmstadt, Germany

ani/or Saftware AG USA, Inc., Restan, VA, United States of America,
and/or thewr suppliers.

Al rights reserved,

njzoemos

FjEmapon Y erter

You can now proceed with the next exercise: Creating a Project.
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9 Creating a Project

In the Application Designer environment, layouts are structured in so-called application projects.
In the development workplace, you see the existing projects on the left. For each project, there is
a tree of layout definitions that you can display when you choose the button containing the project

name. For example:

Tools & Documentation
cisdernos
cisnatural

HTMLE asedGUI

njxdemos

D Mew Layout...

Refresh View

) Preferences

-1 Lavaouts
=[] {default package)

O-menu
calculator
complexData
ctrlactivex
ctributtonlist
ctrlclienttree
ctrlcombodyn
ctrlcontrolgrid
ctridlimenu

For this tutorial, you will now create a project with the name "cisnatfirst".
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~ To create a project

Choose Tools & Documentation to display the list of development tools.

Choose Project Manager in the tree.

A list of existing application projects is now shown on the right.

Choose the New button which is located below the list of application projects.

The following is now shown:

Create Mew Application Project -
Application Project

Create

Please note: you have to create a context root inside your servlet
engine! The name of the context root is the name of the application
project. In the native Application Designer environment this is done
autornatically by restarting the Server,

Enter "cisnatfirst" as the name of your project and choose the Create button.
Your new project is now shown in the list of existing application projects on the right.

The left side, which shows buttons for all existing projects, now also shows a button for your
new project.

You can now proceed with the next exercise: Getting Started with the Layout Painter.
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10 Getting Started with the Layout Painter

B Creating @ NEW LAYOUL ........eiiiii e 44
= Elements of the Layout PaiNter SCrEEN .........covviiiiiii e 46
B Previewing the LAYOUL .......oooi et 47
B VIeWING the XIML COGE ...ttt 48
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Getting Started with the Layout Painter

The Layout Painter, which can be accessed from the development workplace, is used to write the
page layout. This is an Application Designer application itself.

Creating a New Layout

You will now create a layout which is stored in the project you have previously created.

~ To choose a layout template

1 Choose the button for the project cisnatfirst.

The list of layout nodes inside the tree will be empty at the beginning:

cisnatfirst

[ Mew Layout..,
Refresh Wiew
{7 Preferences
-] Layouts
- [C]idefault package)

2 Choose New Layout... in the tree.

The following dialog appears.
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hewl.xml

-- Webpage Dialog

Login online Help | | Absence Invo
Page Popup Request
< | iy
HTML Page Workplace WSDL Page atural Page PDF tpu ip
3  Enter "helloworld.xml" in the Name text box.
This is the name of your layout definition.
4  Select the Natural Page tab at the bottom of the dialog.
a -- Webpage Dialog | x|
Mame hellowaorld.xml

[0 Natural || & Natural
Map Converker
HTML Page Workplace WSDL Page HNatural Page PDF Qutpu qp

5  Select the template for the Natural page (when you move the mouse over this template, the

tool tip "Natural Page" appears).

Natural for Ajax

45



Getting Started with the Layout Painter

The main screen of the Layout Painter appears:

Layout: hellovsarld. xml X

Horme Edit Insart Tonls Extensions EJ I Lﬁ.'

|_: Hew Form ™ C Cpen ¥ Pratocal = Lag AML Schema (H50)

L:-_' Save As T Server Log ¥ Preferences ™
File Ly Configuration
R = Controls
- Page
- [ natpage —m— .
+ T titlebar (Mew Matural Page) = T
= '—: header = Page Header
* | pagebody = Page Body
[.] statushar [ status Bar
Kl J_l = pouble Line Manu
Tt 4 7 Shrip Salection
P
Properties 5 Tab Strip Selecion
7 Tab seladion
% Timer
L Internal Popup Pag
Caontainar
Corntrols
Grids/Trees
‘Web 2.0 f/ Mashup
Advancad
_l Hatural Extensions
1p Warkplace

Note: The file helloworld.xml is stored in the /xml directory of your project.
yory proj

Elements of the Layout Painter Screen

The Layout Painter screen is divided into several areas:

* Layout Area (left side)
This area consists of a layout tree and a properties area.

The layout tree contains the controls that represent the XML layout definition. You drag these
controls from the controls palette into the layout tree. Each node in the layout tree represents
an XML tag.

In the properties area below the layout tree, you specify the properties for the control which is
currently selected in the layout tree.
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" Preview Area (middle)
The preview area shows the HTML page which is created using the controls in the layout area.
This page is refreshed each time, you choose the preview button (see below).

® Controls Palette (right side)
Each control is represented by an icon. A tool tip is provided which appears when you move
the mouse pointer over the control. This tool tip displays the XML tag which will be used in the
XML layout. The palette is structured into sections, where each section represents certain types
of controls.

Previewing the Layout

The layout tree inside the Layout Painter already contains some nodes that were copied from the
template that you chose in the dialog in which you specified the name of the page. To see what
the page looks like, preview the layout as described below.

The preview area is a sensitive area. When you select a control in the preview area (for example,
the title bar), this control is automatically selected in the layout tree.

~ To preview the layout
s Choose the following button which is shown at the top of the Layout Painter.
&

The preview area is updated and you see the page. The page already contains a title bar, a
header containing an Exit button, the page body and a status bar.
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(Preview &
Mew Matural Page &3

Viewing the XML Code

When creating the layout, you can view the currently defined XML code.

> To view the XML code

From the Edit tab of the Layout Painter, choose XML.

A dialog box appears. At this stage of the tutorial, it contains the following XML layout
definition for the nodes which were copied from the template.

<?xml version="1.0" encoding="UTF-8"7>

<natpage natsource="HELLO-A" natkcheck="true" natsinglebyte="true"
xmins:njx="http://www.softwareag.com/njx/njxMapConverter">
<titlebar name="New Natural Page">

<{/titlebar>

<header withdistance="false">

<button name="Exit" method="onExit">

</button>

<{/header>

<pagebody>

</pagebody>

{statusbar withdistance="false">
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</statusbar>
</natpage>

You can now proceed with the next exercise: Writing the GUI Layout.
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11 Writing the GUI Layout
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You will now create the layout for your “Hello World!” application. When you have completed
all exercises in this chapter, the layout should look as shown below and the XML code should be
the same as shown in the section About this Tutorial.

= IE| natpage
-] titlebar {Hello World!)
- header
= button {Say Hello)
-] pagebody
—=FIID0tr
++ hdist (100%)
= icon
=" rowarea (Input Area)
=-IIDtr
A label (Your Name, 100)
[ field (name, 200)
- rowarea (Output Area)
—FIIDtr
A label (Result, 100)
[ field (result, 200)
1 wdist (100)
=PIl it
A label (Input your name and press the 'Say Hello' button.)

[] statusbar

¢ Tip: Preview the layoutand view the XML code each time you have completed an exercise.

If the system finds some wrong or missing definitions while generating the preview page,
there will be a corresponding message in the status bar. From the Home tab of the Layout
Painter, choose Protocol to get more information about these problems.

Specifying the Properties for the Natural Page

You will now specify the following for the Natural page:

® Name for the Natural Adapter (natsource)
The value in the property natsource defines the name of the adapter. The adapter is a Natural
object that your application will use to communicate with the page. It will be generated when
you save the page layout.
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If you do not specify a value for natsource, the name that you have specified for the layout
(without the extension ".xml") will be used as the name for the Natural adapter. If you want to
use the adapter in a development environment other than NaturalONE, you must make sure
that the resulting name matches the naming conventions for Natural object names.

Handling of Strings (natsinglebyte)

Using the property natsinglebyte, you can specify how the strings displayed on this page are
to be handled in the Natural application. Natural knows two types of strings: Unicode strings
(format U) and code page strings (format A). By default, the strings displayed in web pages are
mapped to Unicode strings in Natural. For this tutorial, you will specify that code page strings
are to be used. Therefore, you will set the property natsinglebyte to "true".

If you do not specify a value for natsinglebyte or when you set it to "false", Unicode strings
will be used.

~ To specify the properties for the Natural page

In the layout tree, select the node natpage.

The properties for this control are now shown in the properties area at the bottom.

Make sure that the following properties are specified:

Property Value

natsinglebyte|true
natsource HELLO-A

Specifying a Name for the Title Bar

You will now specify the string "Hello World!" which is to appear in the title bar of your application.

1

To specify the name for the title bar

In the layout tree, select the node titlebar (New Natural Page).

The properties for this control are now shown in the properties area at the bottom. You can
see the default entry "New Natural Page" for the name property.

Specify the following property:
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Property | Value

name |Hello World!

When you click on the layout tree, the node in the layout tree changes to titlebar (Hello
World!).

| Note: Properties that are left blank are not shown in the XML code.

Using the Property Editor

You can also specify the property values using the Property Editor. In this case, you can access
detailed help information on each property.

~ To use the Property Editor

1  Select the control in the layout tree for which you need help, for example, the titlebar (Hello
World!) node.

_

- IE| natpage
+ | titlebar (Hello warld!)
+ = header
+ | pagebody
| statusbar

< L)
Trdd

2 From the Edit tab of the Layout Painter, choose Property Editor.

The following dialog appears.
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A TITLEBAR -- Web Page Di... [

Basic
Basic properties for this control,

name Hello Warld! | | Basic
Binding

textid e

withclose b

align b

image

helpid

titlestyla A

pixelheight M

straighttext b

closetitle ﬂ

Click onto a name of an property to see a help text

Back || Mext | | | Finish || Cancel

The properties of the control are listed.

3  Click on the name of a property to display detailed information on this property. This inform-
ation is shown below the list of properties.

4  Choose the Finish button to close the dialog.

Any changes you have applied in the dialog will be saved.
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Specifying a Name and Method for the Button

You will now specify the string "Say Hello" which is to appear on the button. And you will specify
the name of the method that is to be invoked when the user chooses this button.

~ To specify the name and the method for the button

1  Inthelayout tree, open the header node.

. Note: By clicking the icon of a node, you hide or expand the node’s subnodes.

You can now see the entry for the button with the default name "Exit".
2 Select the node button (Exit).
3 Specify the following properties:

Property |Value

method|sayHello

name |Say Hello

The method needs to be programmed in the adapter. This will be explained later in this tutorial.

Adding the Input and Output Areas

The input and output areas in this tutorial are created using Row Area controls. These controls
can be found in the Container section of the controls palette.

Each row area will contain an Independent Row control which in turn contains a Label and a
Field control. These controls can be found in the Controls section of the controls palette.

For adding controls to your layout, you drag them from the controls palette onto the corresponding
tree node in the layout tree. This is explained below.

~ To create the input area

1 Open the Container section of the controls palette.

When you move the mouse over a control, a tool tip appears which also displays the control
name which will be used in the XML layout. For example:
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Page

Container

ez Independent Row el

:::: Table Row

#+=+ Harizontal Distance

i Vertical Distance

Foow Area

5 Collpow Area (ROWAREA)
% Row Area With Hea

wH Area Header

Area Bady

2 Drag the Row Area control from the controls palette onto the pagebody node in the layout
tree.

The row area is added as a subnode of the pagebody node. The new subnode is automatically
selected so that you can maintain the properties of the row area directly in the properties area.

3  Specify the following property:

Property | Value

name |Input Area

4  Drag the Independent Row control from the controls palette onto the rowarea (Input Area)
node in the layout tree.

When you drop information into the tree, the system will sometimes respond by offering a
context menu with certain options about where to place the control. In this case, the following
context menu appears.

-] pagebaody
- Add as Subnode

| =ta

f+ Add as preceding Mode
+ Add as subsequent Node

| Note: When you move the mouse outside the context menu, the context menu disap-
pears. The control is not inserted in this case.

5 Choose the Add as Subnode command.
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The control is now inserted below the rowarea (Input Area) node. The new node is shown
as itr.

6  Open the Controls section of the controls palette.

Drag the Label control from the controls palette onto the itr node you have just inserted and
specity the following properties:

Property | Value

name |Your Name

width |100

8  Drag the Field control from the controls palette onto the itr node you have previously inserted.

A context menu appears and you have to specify where to place the control.

-] pagebaody
- rowarea (Input Area)l
&2 Add as first Subnode

_ Bz Add as last Subnode
| stati=oan

9  From the context menu, choose the Add as last Subnode command.

10 Specity the following properties for the field:

Property Value

valueprop|name

width 200

~ To create the output area

m  Create the output area in the same way as the input area (add it as the last subnode of the

pagebody node), with the following exceptions:

Row Area
Specify a different value for the following property:
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Property | Value

name |Output Area

Label
Specity a different value for the following property:

Property | Value

name |Result

Field
Specity different values for the following properties:

Property Value

valueprop |result

displayonly|true

| Note: Todisplay the displayonly property, choose the Appearance tab at the bottom

of the properties area. You can then select the required value from a drop-down
list box.

Adding the Image

You will now add the image which is to be shown above the input area. To do so, you will use
the Icon control which can be found in the Controls section of the controls palette.

| Note: The image is provided in Application Designer's /cisdemos/images directory.

- To add the image

1  Drag the Icon control from the controls palette onto the pagebody node in the layout tree.

The icon is added as the last subnode of the pagebody node. It is automatically placed into
an itr (independent row) node.

2 Specify the following property for the icon:
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Property

Value

image

../cisdemos/images/hello.gif

3 Select the itr node containing the icon and choose the following button below the layout tree:

T

The selected node is now moved up so that it appears as the first subnode of the pagebody

node.

4  Specify the following property for the itr node containing the icon:

Property

Value

takefullwidth|true

Adding a

Horizontal Distance

When you preview the layout, you will see that the image you have just added appears centered.

You will now move the image to the right side of the page. To do so, you will use the Horizontal
Distance control which can be found in both the Controls section and the Container section of
the controls palette.

> To add the horizontal distance

1  Drag the Horizontal Distance control from the controls palette onto the itr node containing
the icon.

2 From the resulting context menu, choose the Add as first Subnode command.

The node hdist is inserted into the tree.

3  Specify the following property:

Property

Value

width

100%
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Adding an Instructional Text

You will now enter a text which is to appear below the output area and which tells the user what
to do.

To do so, you will once again use the Independent Row control into which you will insert a Label
control.

. Note: The Independent Row control can be found in both the Controls section and the
Container section of the controls palette.

~ To add the independent row with the label
1  Drag the Independent Row control from the controls palette onto the pagebody node in the
layout tree.

2 From the resulting context menu, choose the Add as last Subnode command.

The node itr is inserted into the tree.

3  Drag the Label control from the controls palette onto the itr node you have just created.

4  Specify the following properties for the label:

Property Value

name Input your name and press the 'Say Hello' button.

asplaintext|true

Note: Go to the Appearance tab to display the property asplaintext.

Adding a Vertical Distance

When you preview the layout, you will see that the text you have just added appears directly below
the output area. You will now move the text 100 pixels to the bottom.

To do so, you will use the Vertical Distance control which can be found in both the Controls
section and the Container section of the controls palette.

> To add the vertical distance

1  Drag the Vertical Distance control from the controls palette onto the itr node containing the
label.
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2 From the resulting context menu, choose the Add as preceding Node command.

The node vdist is inserted into the tree.

3 Specify the following property:

Properties | Value

height |100

Saving Your Layout

If you have not already done so, you should now save your layout.

When you save a layout for the first time, an HTML file is generated (in addition to the XML file)
which is placed into the root directory of your application project. This HTML file is updated each
time you save the layout.

The Natural adapter is also created when you save your layout for the first time. Later in this tu-
torial, you will import this adapter into your Natural library. Your application program will use
the adapter to communicate with the page.

~ To save the layout

= Choose the following button which is shown at the top of the Layout Painter.
=

You can now proceed with the next exercise: Setting Up Your Development and Runtime Environ-
ment for Natural.
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for Natural

Before you start coding, you have to make specific definitions in your Natural environment.

~ To set up your Natural environment

= Setup your Natural development and runtime environment for the required platform as de-
scribed in Setting Up Your Environment previously in this documentation.

This tutorial assumes that you use Natural Studio as your development environment.
Make sure to use the names mentioned below.

* Development Environment
Create a new Natural library with the name CISHELLO.

* Runtime Environment
When you add the new entry to the configuration file, specify "Execute samples" as the
session name:

{session id="Execute samples" trace="false">

"Execute samples" is the entry that will later be available for selection in the logon page.

You can now proceed with the next exercise: Creating the Natural Code.
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13 Creating the Natural Code

= |mporting the Adapter into Natural

= Creating the Main Program .........

= Testing the Completed Application
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Importing the Adapter into Natural

You will now import the generated adapter into Natural to make it available to your application.

When you saved your page layout, Application Designer created the Natural adapter HELLO-A for
your page. This is the name that you have specified earlier in this tutorial. Your application program
will use the adapter to communicate with the page. The adapter has been generated into the fol-
lowing directory:

<installdir>/cisnatfirst/nat

Note: The location of <installdir>depends on your application server environment.

~ To import the adapter

Import the adapter source into the Natural library CISHELLO which you have created earlier
in this tutorial. To do so, use either drag-and-drop or the import function of the SYSMAIN
utility.

The adapter code looks as follows:

* PAGELl: PROTOTYPE --- CREATED BY Application Designer --- /*<R0>>
* PROCESS PAGE USING '"XXXXXXXX' WITH

* NAME RESULT

DEFINE DATA PARAMETER

1 NAME (U) DYNAMIC

1 RESULT (U) DYNAMIC

END-DEFINE

*

PROCESS PAGE U'/cisnatfirst/helloworld" WITH
PARAMETERS

NAME U'name'

VALUE NAME

NAME U'result'

VALUE RESULT

END-PARAMETERS

*

* TODO: Copy to your calling program and implement.
/*/*( DEFINE EVENT HANDLER

* DECIDE ON FIRST *PAGE-EVENT

* VALUE U'nat:page.end',U'nat:browser.end’
e /* Page closed.

o IGNORE

* VALUE U'sayHello'

2 /* TODO: Implement event code.

w PROCESS PAGE UPDATE FULL

* NONE VALUE
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3 /* Unhandled events.
# PROCESS PAGE UPDATE
* END-DECIDE

/*/*) END-HANDLER

*

END /*<<RO>

Stow the adapter.

Creating the Main Program

You will now create the main program which uses the adapter to display the page and which
handles its events. The name of the program will be HELLO-P and you will store it in the library
CISHELLO.

This description assumes that you are working with Natural Studio.

~ To create the main program

1
2

Make sure that the library CISHELLO is selected.
From the Object menu, choose New > Program.

Enter a DEFINE DATA statement:

DEFINE DATA LOCAL
END-DEFINE

Import the adapter interface into the DEFINE DATA statement:

Place the cursor in END-DEFINE.

From the Program menu, choose Import.

In the resulting dialog box, select the Adapter option button.
Select the object HELLO-A.

Select all importable data fields.

SRR

Choose the Import button.

The result is your completed DEFINE DATA statement:
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DEFINE DATA LOCAL

1 NAME (A) DYNAMIC

1 RESULT (A) DYNAMIC
END-DEFINE

Enter the PROCESS PAGE statement. The statement uses the page adapter to display the page
in the web browser and to pass data to the controls on the page:

DEFINE DATA LOCAL

1 NAME (A) DYNAMIC

1 RESULT (A) DYNAMIC
END-DEFINE

*

PROCESS PAGE USING 'HELLO-A"
WITH NAME RESULT

Initialize the page data. In the page layout definition, the property name has been bound to
the FIELD control with the label Your Name. For the property name, a parameter NAME has
been generated into the parameter data area of the adapter. Thus, in order to preset the FIELD
control, we will preset the variable NAME with the value "Application Designer".

DEFINE DATA LOCAL

1 NAME (A) DYNAMIC

1 RESULT (A) DYNAMIC
END-DEFINE

*

NAME := 'Application Designer'
PROCESS PAGE USING '"HELLO-A'
WITH NAME RESULT

Handle the events that can occur on the page. A template for the event handler code has been
generated as a comment block into the page adapter HELLO-A. List the adapter HELLO-A and
copy this comment block into your main program and terminate the program with an END
statement:

DEFINE DATA LOCAL

1 NAME (A) DYNAMIC

1 RESULT (A) DYNAMIC
END-DEFINE

*

NAME := '"Application Designer'
PROCESS PAGE USING 'HELLO-A'
WITH NAME RESULT

*

DECIDE ON FIRST *PAGE-EVENT
VALUE 'nat:page.end’',U'nat:browser.end’
/* Page closed.

IGNORE

VALUE 'sayHello'
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/* TODO: Implement event code.
PROCESS PAGE UPDATE FULL

NONE VALUE

/* Unhandled events.

PROCESS PAGE UPDATE

END-DECIDE

*

END

After the page has been displayed, the user raises events on the page by using the controls.
The name of the raised event is then contained in the system variable *PAGE - EVENT. Depending
on the event, the program modifies the page data, resends it to browser with a PROCESS PAGE
UPDATE FULL statement and waits for the next event to occur.

The predefined events nat:page.endand U'nat:browser.end" are raised when the user closes
the page or closes the browser. The event sayHe11o is raised when the user chooses the Say
Hello button. Previously in this tutorial, you have bound the event sayHel10 to this button
while designing the page. The NONE VALUE block should always be defined as above. It contains
the default handling of all events that are not handled explicitly.

8  When the event sayHel10 occurs, we want to display a greeting in the FIELD control with
the label Result. Therefore, we modify the variable RESULT (which is bound to the correspond-
ing FIELD control in the page layout) accordingly before we resend the page data.

DEFINE DATA LOCAL

1 NAME (A) DYNAMIC

1 RESULT (A) DYNAMIC
END-DEFINE

*

NAME := "Application Designer'
PROCESS PAGE USING 'HELLO-A"'
WITH NAME RESULT

*

DECIDE ON FIRST *PAGE-EVENT
VALUE 'nat:page.end',U'nat:browser.end’
/* Page closed.

IGNORE

VALUE 'sayHello'

/* TODO: Implement event code.

COMPRESS 'Hello, ' NAME "!' TO RESULT
PROCESS PAGE UPDATE FULL
NONE VALUE

/* Unhandled events.
PROCESS PAGE UPDATE
END-DECIDE

*

END

The main program is now complete.
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If you have not yet saved the program, save or stow it now with the name "HELLO-P".

9 Catalog all modules in the library CISHELLO.

Testing the Completed Application

You will now run the application in your web browser and check whether it provides the desired
result.

The generated HTML file helloworld.html (which is updated each time you save your layout) can
be found within the root of your application project, that is in <instal1dir>/cisnatfirst.

This HTML page has some prerequisites concerning the browser workplace in which it is running.
Therefore, it is per se not usable as a directly accessible page but needs to be embedded into a
frame providing a defined set of functions.

It is necessary to logon to Natural before starting an application. Therefore, Natural applications
are started using a logon page.

~ To test the application

1  Enter the following URL inside your browser:
http://localhost:8080/cisnatural/servlet/StartCISPage?PAGEURL=/cisnatural/NatLogon.htm]

The logon page should now appear.
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rCunnectiun details

Session ID: IExecute Samples LI
Host name: Port;
Llser name: Password:

MHatural application:

Matural parameter:

Language: |Eng|i5h ;l

rChange Password -

Mew password:

Fepeat new
password:

Conneckt

If the logon page is not displayed, check the following:

® URLs are case-sensitive. Double-check your input.

® Check whether the file NatLogon.html is available in the directory cisnatural.

2 Onthelogon page, select the entry Execute samples from the Session ID drop-down list box.
You have prepared this entry earlier in this tutorial when you have set up the runtime envir-
onment.

3 Provide your user ID and password valid for the machine on which the Natural application
will be running.

4  In the Natural application text box, enter the following information, depending on your
Natural platform:

* Natural for Mainframes
Enter the name of the Natural program that is to be started. In our case, this is HELLO-P.

* Natural on Linux and Cloud
Enter the name of the Linux shell script that is used to start Natural. By default, this is
nwo.sh.

* Natural for Windows
Enter the name of the Windows command file (.bat) that is used to start Natural. By default,
this is nwo.bat.

5  In the Natural parameters text box, enter the following information, depending on your
Natural platform:
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® Natural for Mainframes
Enter the dynamic Natural profile parameters that are necessary to start your application:

STACK=(LOGON CISHELLO)

| Note: With Natural for Mainframes, is recommended to specify the Natural program

that starts the application in the Natural application text box instead of passing it
with the profile parameter STACK.

® Natural on Linux and Cloud and Natural for Windows
Enter the Natural command line that is necessary to start your application:

STACK=(LOGON CISHELLO;HELLO-P)

6  Choose the Connect button.

Your application should be started now.

7  Enter your name and choose the Say Hello button.

The page should now successfully “talk” to your adapter.

Input Area i
Your Name Jo

Output Area i
Result Hello, Jo !

You have now completed this tutorial. See the remaining section of these First Steps for some
background information.
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= Name Binding between Controls and AdapLer ..........couvviiiiiiii
m Data EXchange at RUNTIME ..ottt e e e e

= Files and their Locations
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Name Binding between Controls and Adapter

Which are the critical parts when building the “Hello World!” application?

The NATPAGE control in the layout points to the name of the adapter object (property
natsource).

The FIELD control in the layout points to the property name of the adapter (property valueprop).

The BUTTON control in the layout points to the event sayHel10() of the adapter (property
method).

There is a name binding between the layout definition and its corresponding adapter. This is the
simple and effective approach of the development process: The adapter represents a logical ab-
straction of what the page displays. All layout definitions are kept in the page - all the logic is kept
in the adapter. (Or better: behind the adapter. The adapter itself should only be a facade to the
“real” application logic.)

Data Exchange at Runtime

What happens at runtime?

When the user starts a Natural session from the logon page, the Natural program that the user
specified in the command line is started.

The Natural program executes a PROCESS PAGE statement, using an adapter.

The PROCESS PAGE statement passes the name of the HTML page to be used and the initial page
data to the browser.

The browser displays the page. JavaScript code on the page distributes the initial data to the
controls.

The user provides some input, for example, enters the name. The content change is stored inside
the page. The Natural program is not yet involved.

The user does something which causes a flush of the changes (for example, the user chooses a
button). Therefore, all registered data changes are packaged and are sent through the adapter
to the Natural program, including the information which event has been raised.

The Natural program receives the modified data.
The system variable *PAGE-EVENT receives the name of the raised event.

The event handler in the Natural program modifies the data and resends it to the page using a
PROCESS PAGE UPDATE statement.

And so forth.
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With a standard HTTP connection, only the changed content of the screen is passed when operating
on one page. The layout is kept stable in the browser. Consequently, there is no flickering of the
page due to page reloading.

All steps described in the list above are done completely transparent to your adapter; i.e. you do
not have to cope with session management, stream parsing, error management, building up HTML
on the server, etc. You just have to provide an intelligent HTML page by defining it in the Layout
Painter and an adapter object.

Files and their Locations

Have a look at the files created for your “Hello World!” application and take notice of the directory
in which they are located.

All files are located in the directory <installdir>/cisnatural/cisnatfirst. The <installdir>/cisnat-
ural directory is the directory of the web application instance. The <instal1d7ir>/cisnatural/cisnatfirst
directory is the directory that has been created for your new project.

® The XML layout definition is kept in the <instal1dir>/cisnatural/cisnatfirst/xml directory.

® The generated HTML page is kept directly in the project directory. There are possibly also some
other files inside this directory that start with "ZZZZ". These files are temporary files used when
previewing pages inside the Layout Painter.

® The generated Natural adapters are kept in the directory <instal1dir>/cisnatural/cisnatfirst/nat.

® Inthe directory <installdir>/cisnatural/cisnatfirst/accesspath, “access restriction” files are gener-
ated. If you view these files inside a normal text editor (such as Notepad), you see that one file
is maintained for each page; it holds the information about which properties are accessed by
the page.
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I I I First Steps Responsive Pages

This tutorial explains how to build a responsive application and is organized under the following
headings:

About this Tutorial

Preparing your NaturalONE Workspace

PART1: Developing the Main Application Page
PART2: Developing the Pop-Up Page
PARTS3: Putting it All Together

Tutorial Reference Implementation
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15 About this Responsive Pages Tutorial

In this tutorial you will build a responsive application with two pages. You will use Natural ONE
and Natural for Ajax. It shows you how to use the responsive control set of Natural for Ajax.

Here you can see what your application will look like when you have completed all the steps in
this tutorial:
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Natural for Ajax - Responsive Tutorial

Show

e

»

10 % entries

Firsthame

First1

First2

First3

First4

Firsts

First6

First?

First8

First9

First10

Showing 1 to 10 of 30

entries

Lastname

Last1

Last2

Last3

Lastd

Lasts

Lastb

Last?

Lasts

Last9

Last10

Search:

E-Mail

First.Last1@email.com
First.Last2@email.com
First.Last3@email.com
First. Lastd@email.com
First.Last5@email.com
First.Laste@email.com
First.Last7 @email.com
First.Last8@email.com
First.LastS@email.com

First.Last10@email.com

Previous 2 3 Next

About ™~ o
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Edit User Information

S software~

Firstname

First1

Lastname

Last1

Email

First.Last1@email.com

Userid

User1

Save Cancel

Item for userid User1 has been updated

Your application will work as follows: When you click the pencil icon in the grid, a pop-up window
will open to modify the item. When resizing the browser window, the grid page as well as the
pop-up page will adapt to the size of the browser window in a responsive way.

The Tutorial is split into three parts. You can do Part 1 and/or Part 2 independently of the other
parts. Part 3 requires that you have done Part 1 + 2.
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Learning Estimated Time

Part 1|Develop a responsive page with an application bar and a grid. 20 min

Part 2| Develop a responsive page with input controls including validation, displayonly |15 min
settings and submit buttons.

Part 3| Page navigation between two pages. Integrate a page as pop-up. 15 min

This tutorial assumes that you have started Natural ONE and switched to The Natural ONE Per-
spective. This Tutorial uses the Project Explorer view.
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16 Prepare your NaturalONE Workspace

= Perspective Settings ........cccvvviiiiiiii

= Create a Natural Project with a User Interface Component
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Perspective Settings

Click Window > Preferences to apply the settings described below.

To run the responsive application, it is required to use an external web browser. The internal web

browser of Eclipse does not fully support responsive rendering.

Preferences

| type filter text

w General ~
Appearance
Capabilities
Compare/Patch
Content Types
Editors
Globalization
Keys
Link Handlers
Metwerk Connection:
Motifications
Perspectives
Project Matures
Cuick Search
Search
Security
Service Policies
Startup and Shutdow
Tracing
Ul Freeze Monitoring
User Storage Service
Web Browser
Workspace

Ant

Data Management

Gradle w
£ >

@ gl @

Web Browser

Add, remove, or edit installed web browsers,
The selected web browser will be used by default when web pages are opened,
although some applications may always use the external browser,

(") Use internal web browser

®ilse external web browser

External web browsers:

Default systern web browser
Firefox

Internet EBxplorer

Microsoft Edge

Chrome

Microsoft Edge

OooonEl

Restore Defaults

|App|],r and Close

Mew...
Edit...

Bemove

Search...

Detect

Apply

Cancel

We want that the Natural adapters are always regenerated and compiled automatically whenever
we change a responsive layout.
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O X
type filter text N | L= g ~ §
General 5
Ant Builder Build Sequence Project Options LastMsg
Data Management General
Gradle Rebuild dependent objects
Help Confirm resetting flags
Install/Update [#] Cenfirm cancellation of builds
Java
Java EE Server
Java Persistence [ Build Natural projects automatically;
Language Servers [ Seratch server ohjects
Maven X X X
Seratch server objects for shared libraries
Mylyn
Oomph Scratch server objects for private libraries
Plug-in Development Confirm scratching server objects
Report Design 4] Prompt on compile errors
Run/Debug Confirm deleting shared libraries
Server Confirm deleting private libraries
w Software AG X X X
Ajax Developer Confirm server processing of selected objects
Business Services Iterations for update or build on server environment | 1
Code Generation
Construct Time stamp
EntireX [] Check time stamp on server
Matural Confirm time stamp conflict
Predict Description and ( Syntax parsing of dependent objects
Request Document i
Testing [JEnable syntax parsing
UDDI Registries Parse syntax automatically
Web Services Stack Stop after first error
Terminal
TextMate Console
Validation [ Console output
Version Control (Team) Limit console output
Web Console buffer size (characters): | 800000
Web Services
XML
@ o Restore Defaults Apply
® i &
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File Edit Mavigate 5earch | Project Ajax Developer Run  Window Help

Y - la] €5 | ! Open Project i
5 Project Ex... &3 m MNatural Close Project
2% 7|8, Build Al Ctrl+B
' Build Project
Build Working Set > k
Clean...

~  Build Autornatically

L e A ]

Parse All Crl+Alt+L
- - b
Parse Syntax Automatically
2] Generate NATdoc... -
Properties v

Create a Natural Project with a User Interface Component

In the File menu, select New > Natural Project.
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workspace_responsive_tutorial - Software AG Designer

File Edit Mavigate Search Project Run  Window Help
New Alt+Shift«M > = |
Open File... -

[} Open Projects from File System... =
Recent Files =
Close Editor Ctrl+W | dEK
Close All Editors Ctrl+ Shift+W
Save Ctrl+5 E
Save As... =

=]

Save All Ctrl+Shift+5 '-'_‘1
Revert '3"——|
A

Move... RA
o

Rename... F2 |
Fa

& | Refresh | T
: - Ee

Convert Line Delimiters Te =a
: ¥
Print... Ctrl+P E-k

= Import. e

&g Export. IES
P rti Alt+Ent &

roperties +Enter i
Switch Workspace m|
Restart My
Exit

i}
i}

Predict Components Folder
Matural Project

Matural Library

Project...

Program

Subprogram

Subroutine

Function

Copycode

Helproutine

Text

Global Data Area

Local Data Area

Parameter Data Area

Map

oom

Error Message

Page Layout

User Interface Component
Style Sheet

Responsive Style Sheet
Object Using Construct Model

Example...

COther... Ctrl+M

Set NaturalAjaxResponsiveTutorial as project and click the Finish button.
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Mew Matural Project O x
Create a Natural Project N1

This wizard creates a Matural project

Project: NaturaIAjaxRespnnsiveTutnriaﬂ

Use default location
Location: | Ghmyworkspaces\workspace_responsive_tutorial Browse...

Create the library root folder
[] Group new ohjects by object type

® < Back Mext = Finizh Cancel

In the Project Explorer right click on the Natural-Libraries folder of the created project and select
New > Natural Library.
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i Project Explorer 53 m MNatural Mavigator

Wel -project

Set NJXTUTOR as Library and click the Finish button.

BS 7886
12 MaturalAjaxResponsiveTutonal-» natural-runtime (2]
» [~ .settings
&= Matural-Librari~~
yEl -natural

Mew
Go Into

Show In

Show in Local Terminal

Copy
Paste

R B O

Project...

File
Folder
SQL File

Matural Library
Matural Project

Mew Matural Library

Create a Natural Library

This wizard creates a Matural library

Project: | MaturalAjaxResponsiveTutorial Browse...
Folder Browse...
Library: | MJXTUTOR
Use new folder as library folder
Load library properties from secured envirenment
@ Einish Cancel

In the Project Explorer right click on the SRC folder of the created library and select New > User
Interface Component.
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by Project Explorer 52 Ml Natural Mavigator = B8

ES 7| H85| e 8

v (2 NaturalAjaxResponsiveTutorial- > natural-runtime (1)

[= settings
~ [ Matural-Libraries
v [ NIXTUTOR
[ ERR
& RES
= .nfr:l MNew » ™ Project..
i project ~ Gelnte (9 File
Show In Alt+Shift+W > (7 Folder
Show in Local Terminal * B S0L File
=S| Copy Ctrl+C | @& Matural Library
Paste Chrl+V & Matural Project
#  Delete Delete 2| Predict Components Folder
Remove from Context Ctrl+Alt+Shift+ Down T Copycode
Maove... Ez DOM
EITIT R = | Error Message
ix |mport. E Function
iy Export.. :: Global Data Area
&) Refresh F5 ﬂ'—_| Helproutine
:z Local Data Area
Extract IDL... B Map
Generate Java Client.. [Ms  Object Using Construct Model
Generate Web Service... ¥ Darameter Data Area
Matural ONE * Zl  Program
ﬂ Predict Components > Subprogram
Code Generation * B Subroutine
@ Coverage As > b Text
{J Funhs » [f5 Pagelayout
%5 Debug As * [ Responsive Style Sheet
Profile As » [0 Style Sheet
Restore from Local History... (=l User Interface Component

The dialog Enable Project for Ajax Developer is opened. Click the Finish button.
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O X

Enable Project for Ajax Developer

This wizard enables the project for Ajax Developer.

Path: /MaturalAjaxResponsiveTutorial

Runtime Yersion

Matural for Ajax 9.2.1

Web application configuration

Web applications: Development w
Selected configuration details
Web server folder: Chmyworkspaceshworkspace_responsive_tutoriall.natural| | Browse...

Web server connection: localhost: 28080
Web application folder Chmyworkspaceshworkspace_responsive_tutoriall.natural| | Browse..
Web application name: cisnatural
Add webconfig folder
[ ] Add webconfig folder

Layout display mode
(OSWT (Deprecated) (® HTML

Layout refresh mode
®@off O0n
User interface component folder support

Create root folder

Use workspace relative paths

® Einizh Cancel
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The wizard Create a User Interface Component is opened. Set responsive_tutorial as Component

name and click the Next button.

Mew User Interface Component O >
Create a User Interface Component
This wizard creates a user interface component.
Project
Project name: | /MaturalfjaxResponsiveTutorial Browse...
Marne
Component name: | responsive_tutorial
Contents
MNew
(@ Create new user interface component
Enable
() Enable a folder as user interface component  Browse. .
Impart internal
() Import user interface component from internal server
Existing components:
Import external
() Import user interface component from gxternal server
External component: Browse...
. -
@/' < Back Mext = Finish Cancel
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The next wizard page appears. You can see that the correct Natural source folder for your Natural
adapters is automatically selected. Click the Finish button.

Mew User Interface Component O >

Create a User Interface Component

This wizard creates a user interface component.

Matural adapter folder
Matural adapter folder | o Matural-Libraries/ NI TUTIR,SRC Browse...

Layout Painter configuration

Mame validation: | ((la-z_/ X1 a-zA-Z,0-9,_ .. WL [alioh)

[ ] Dizable name validation

Layout direction
(®) Left to right Oﬂight to left

Ajax configuration file
[] Use cisconfigxml of User interface component

?) < Back Mext = Finish Cancel
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You have successfully created an Ajax enabled Natural project and a User Interface Component
for this tutorial. In Project Explorer you will see:

5 Project Explorer 52 [ Matural Navigator = 0O
ES VI 8B ¢
v Té MaturalAjaxResponsiveTutonal- = natural-runtime (1)
= .settings
w &= Matural-Libraries
v [ NJXTUTOR

[#2 ERR
& RES
(iE SRC

v (B} User-Interface-Components
v (5 responsive_tutorial
= cisconfig
= multilanguage
[= styles
xml
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B THE Data Grid ...t e e a e e e e 102
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PART1: Develop the Main Application Page

Our main application page will contain:

" A responsive application bar

" A responsive data grid.

We will use a template which already contains a basic application bar.

The Application Template

Right click the folder responsive_tutorial in Project Explorer and select New > Page Layout

{5 Project Explorer &3 ﬂ Matural Mavigator =
=IR=Sl

son L1

v b_—':"- MNaturalAjaxResponsiveTutorial-» natural-runtime (1)
[= .settings

~ [ Matural-Libraries
w [ NIXTUTOR

2 ERR
E RES
(3E SRC

v (B User-Interface-Components
w £ responsive_tutorial

[[El

N=

= cisconfig

= multilanguage

[= styles

xml

Q «cisapplication

%] ciseditorconfigaxml
.natural
project

E E

)

O P [

MNew

Go Into

Show In

Show in Local Terminal

Copy
Paste

Delete
Remove from Context
Move...

Rename...

Import...
Export...

Refresh

Matural OME
Predict Components
Code Generation

Ajax Developer

Coverage As
Run As
Debug As
Profile Az

Restore from Local History...

Alt+5Shift+ W

Ctrl+C
Ctrl+V
Delete
Ctrl+Alt+Shift+ Down

F2

F5

»

>

W BHEY R O

ye
Ak

T

o
u

Il:ﬂ

3
Fa

# o [

=)
A
m

Project...

File
Folder
SOL File

Matural Library
Matural Project

Predict Components Folder

Copycode

DoM

Error Message
Function

Global Data Area
Helproutine
Local Data Area
Map

Object Using Construct Model

Parameter Data Area
Program
Subprogram
Subroutine

Text

Page Layout
Responsive Style Sheet
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In the Natural Page tab scroll a little bit down and select the template Natural Responsive Page
- Application Bar. Set tutorial_main in the Page layout field. Set TUTMAIN-A in the Natural

adapter field. Click the Finish button.

Mew Ajax Page Layout O x
Create a Ajax Page Layout
Select a user interface component.
User interface component: | /MaturalAjaxResponsiveTutonial/User-Interface-Components/responsive_tutonal | Browse...
Page layout: | tutorial_rmnain |
Matural adapter: | TUTMAN-A| |
Matural Page Workplace Standard Pop-up Dialogs  PDF Output  HTML Page
== -
Matural Responsive Page - Sidebar
Ftsw b by i Twal ]
Matural Responsive Page - Application Bar
Y
‘ AlAat]l ncmn \M:h:r:lhl:ﬂ Aannan Dana o
@

The tutorial_main layout is opened in Layout Painter Editor. It contains an application bar with

a text at the left-hand side and a drop-down button and an icon at the right.
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The Application Bar

In this step the controls in the application bar will be explained and we will adapt the application
bar.

You see a BMOBILE:HORIZONTALBAR control, which contains a BMOBILE:BARTEXT, a
BMOBILE:FORMINLINE and a BMOBILE:ICON control.

Click on the text Application Title in the Preview Area (middle). This will select the
BMOBILE:BARTEXT control. You can now see and modify the properties of this control.

[ tutorial_mainxml 22 = B [ Properties % Y § = 0
t = Pravie Controls
i e e - All Property Value
T Responsive Maps/Charts i
= na . ' W basic
—_ ) ! e 1 OpenStreetha Props
¢ =[] bmobile:horizontalbar Application Title; About ¥ o e comment
. e e A ap Marker
[ bmobile:bartext (Applicatic Map Layer name Application Title
. . nameprop
+ [ bmobile:forminline Map Point strighttext
+|[] bmobile:container Map Line syle
[C1] bmobile: dynmodal Map Polygan styleclasses  navbar-brand

The BMOBILE:BARTEXT is a control to render texts in bars. In our example we want to add our
application title as text here. You see that as styleclasses the css class navbar-brand is set. This
increases the font-size and adds some shadow and padding. We keep this setting.

Our application name is "Natural for Ajax - Responsive Tutorial". Change the name property to
Natural for Ajax - Responsive Tutorial.

]
L 3
5T

] Properties 3

[

All Property Value

Props w Basic
comment

name Matural for Ajax - Responsive Tutorial
nameprop

straighttext

style

styleclasses  navbar-brand

textid

Press <ctrl s> to save the change. This will refresh the Preview Area.
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Click on the About button in the Preview Area (middle). In the Layout Area (left) a
BMOBILE:DROPDOWN control is selected and you can now see and modify the properties of
this control in the Properties v .

[ tutorial_mainxml 53 = B [ Properties %
Layout = Preview B Controls

Responsive Maps/Charts  All

--[@] natpage e .
= £ bmobile:horizontalbar Natural for Ajax - Responsive Tutorial | About~ | o Opensireethizp uoes
[[] bmobile:bartext (Natural for Ajax - R | e = Q::Z C;;::“
= [ bmobile: forminline @ Version Info Map Point
+ =] bmobile:dropdown (About) ) 8 Map Line
(5 bmobile:icon My Application ... [ Map Polygon
+ [ bmobile: container
[ bmobile:dynmodal

dropdown-menu-right

mr-2
title About this applicaton

name About

CEEE

The BMOBILE :DROPDOWN and the BMOBILE:ICON control are grouped in a
BMOBILE:FORMINLINE container control. Use a BMOBILE:FORMINLINE container
whenever you want to render several form controls — like buttons, texts, fields, icons,... — side by
side on a single horizontal row or bar.

Have a look at the properties of the BMOBILE:DROPDOWN: As menuclasses the css class
dropdown-menu-right is set. This aligns the opened dropdown on the right side of the dropdown
button. As buttonclasses property you can set classes to change the rendering of the dropdown
button itself. We keep the default rendering. As styleclasses the css class mr-2 is set. Click on the
small button right to the text “mr-2”. This will open the “Select styleclasses” dialog. In the lower
half of this dialog there is a dropdown box. This dropdown contains the most frequently used re-
sponsive classes for this control. Select mr-*. Now you can see a help text below the dropdown
which explains the class.
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Select styleclasses ot

Edit field or select from dropdown

mr-2

Select class
imr-* L v Add

Margin right, * can be a number between 1 and 3

QI Cancel

Click the Cancel button to close the dialog. In our example the mr-2 class puts a vertical distance
between the dropdown button and the icon.

In the Preview Area click on the text My Application of the opened dropdown. This will select a
BMOBILE:FLABEL control. In a BMOBILE:DROPDOWN control you can have rows with all
kinds of controls. We simply apply a different text to the name attribute.

[ “tutorial_mainxml & = B [ Properties ¢ E
Layout = Praview | Controls
- Responsive Maps/Chares Al Property Velue
= [ natpage v Appesrance
. e Props
= [ bmobile:horizontalbar Natural for Ajax - Responsive Tutorial About ¥ o a“";"“:”“a” ? invisiblemode
2 Map
[[I] bmobile:bartext (Natural for Ajax - Res (9 nap Layer straighttext
= [EI] bmobile: forminline B Version Info style
25 Map Point styleclasses
== bmobile:dropdown (About) Map Line e
#2332 bmobile:row Map Polygon titlestraighttext
=122 bmobile:row v Basic
- =% bmobile:col [ Responsive Chart comment
A bmobile:flabel (My Applica ] Responsive Chart Data name
[El bmobile:icon &P Responsive Pie Chart textid
bmobil N G Google Map  Binding
] bmobile:container 82 Mashzone  namq prop
................ =

Press <ctrl s>. In the Preview Area click on the icon to the right of the dropdown. This will open
amodal dialog in the Preview Area and will show the properties of the BMOBILE:ICON control
in the Properties view.
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5 tutorial_mainxml 33 = O [ Properties 53 AlEY B 8
Layout = Preview ‘Controls.
= Responsive Maps/hars | All Property Value
= [ natpage « Basic
[# openstreetial Events
= ] bmobile:horizontalbar P P comment
Map Marker Props heloid
[[I] bmobile:bartext (Natural for Ajax - Ret . . . . elpi
Application Help Dialog B wap tayer iconu /HTMLBasedGUl boststrapicons/icons/questio (2]
= [0l bmobile: forminline Map Point |
iconurlprop
[ bmobile:dropdown (About) Viap tine D e
*/%: bmobilezrow Map Polygon method modal:applicationhelp
=222 bmobile:row style
SH=t bmobile:col ] Responsive Chart styleclasses baricon baricon-svg
A bmobile: flabel (Natural Aja lO}her sources of ;m; Responsive Chart Data title Click to open Help Dialog
R Pie Chart
[l bmobile:icon information g Respance e cha :\Segwm .
oogle Map itlestraightter
[II] bmobile:container 88 mashzone titletextid
[ bmobile:modal ] Mediaupload visibleprop
[Tl bmobile:dynmodal You are about to enter Software AG's ] imagetile Upload ~ Miscellaneous
product documentation portal. The fastest [l Mediapreview testtoolid
way of finding content is by entering a ] imagepreview v Natural
product name in the product name search [0l Mediaupload Button mm:wmment
i Mediapreview Button npenatname
fie top et % Imageupload Button npanatstringtype
There are other sources of information. 0] magepreview Button
i ettt i [l video

The iconurl property sets the icon image. Natural for Ajax contains an icon library with SVG icons
and icon fonts. Click on the small button next to the property value “../HTMLBased GUI/bootstrapi-
cons/icons/question-circle-fill.svg”. The dialog Enter Image URL opens.

Enter Image URL

Enter the UREL

or Browse to select an

Image

or select an 5VG icon from the Bootstrap lcons library

. HTMLEBased GUl/bootstrapicons/icons/question- circle-fill.sv

oK

Cancel

V& lcons

Browse

When clicking the SVG Icons button you can select among more than 1300 SVG icons. Click the

Cancel button.

The value of the method property defines which modal is opened. Each modal has a modalid.
The method to open the modal is always “modal:<themodalid>". To see the corresponding
BMOBILE:MODAL control with its properties, select it in the Layout Area.
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[ tutorial_mainxmi 53 =g

[ Properties &2 e Y
Layout = Preview | Controls
@ o Responsive Maps/Charts All Property Value
- [ natpage - v Basic
e Props.
= £ bmobile:horizontalbar 3‘;:";::::“" comment
[[] bmobile:bartext (Natural for Ajax - Res o . Map Laer draggable true
=[] bmobile:forminline Application Help Dialog o Lo modalbodystyle  height800px;
" Map Point modalid applicationhelp
- = bmobile:dropdown (About)
+drop Map Line pageurl https://documentation.softwareag.com/
# 222 bmobile:row Map Polygon pageurlprop
= i bmobile:row ~ resizable true
- bmobile:col [l Responsive Chart straighttext
A bmobile:flabel (Natural Aja Other sources of il Responsive Chart Data titlename Application Help Dialog
2 bmobile:icon information & Responsive Pie Chart v Miscellaneous
: G Google Map testtoolid
= [ bmobile:container . - 22 Mashzone
[Tl bmobile:modal 0] Medieupioad
[ bmobile:dynmodal - You are about to enter Software AG's - (] imagefite Upioad

Underneath the modalid is the pageurl property. Here you can set any URL to a valid page access-
ible as URL in your browser.

SUMMARY
We have built a simple application bar showing:

® Application Name
® Version Information (Dropdown)

* Help Icon with a Help Pop-Up.

We only had to adapt an existing template for this.

The Data Grid

We will use the controls palette to add a data grid with several different columns and behavior
to our page.

In the Controls Palette (right) open the Responsive Grids section. Drag and drop the Simple
Grid to the bmobile:container node in the Layout Area (left).

[TE tutorial_mainxml £% = 8 Orrg

Layout
El @ natpage
=[] bmobile:horizontalbar
[[] bmebile:bartext (Natural for Ajax - Res
= [[I bmobile: forminline
= = bmobile:dropdown {About)
+ 222 bmobile:row
=222 bmobile:row

=ri* bmobile:col
A bmobile:flabel (My Applica
[zl bmobile:icon
- [[I] bmobile:container
[[I bmebile:modal
[ bmobile:dynmodal

Preview

Natural for Ajax - Responsive Tutorial

About~ o

Controls
Responsive Maps/Charts Al
Nen-Visual Controls
Responsive Contrals
Responsive Fages

Press <ctrl s>. Open all child nodes of the bmobile:simplegrid node.

Container
Respansive Grids

B simple Grideolumn

B lcon Grideolumn

= simple Grid

F simple Header Calumn
SimDIE

E13 Simple Row

The BMOBILE :SIMPLEGRID control contains a row with grid header columns (BMOBILE:SIM-
PLEHEADERROW) and a row with data columns (BMOBILE:SIMPLEROW). Click on the
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bmobile:simpleheadercol node and change the value of the property name to Firstname. Press
<ctrl s>.

& tutorial_mainxml 52 = B [ Properties &I
Layout = preview 5 || Contrals
Responsive Maps/Charts | Al Preperty Value
- @ natpaga . . . Nen-Visual Controls v Basic
- [ bmobile:herizontalbar Natural for Ajax - Responsive Tutorial E—— comment
[[J] bmobile:bartext (Natural for Ajax - Responsive Tut i (s name Firstromel
About = o Respansive Container straighttext
+ ([ bmobile:forminline Responsive Grids e
- mff”“"‘le:c“”ta'”e' Show 10 & entries H Simple Gridcolumn styleclasses
=111 bmobile:row F 1con Gridealumn textid
! bmobile:col Search EZ simple Grid title
== bmobile:simplegrid (gridlines, 100%) ’ [ Simple Header Column titlestraighttext
= 133 bmobile:simpleheaderrow B 3 Simple Header Row titletextid
+ A bmobile:simpleheadercol (Firstname) ! Firstname * Simple Row
= 137 bmobile:simplerow !
+ [ bmobile:simplecol (column) . .
[ bmobile:modal No data available in table
Copy and paste the bmobile:simpleheadercol twice
3 - -
[[5| tutorial_main.xml &3
{ =
Layout Preview
= - - Natural
-_| bmobile:horizontalbar atura

[l bmobile:bartext (Natural for Ajax - Responsive Tut
About -

+{[I] bmobile: forminline
-] bmobile:container
=222 bmobile:row
- "% bmobile:col

- bmobile:simplegrid (gridlines, 100%)

~33: bmobile:simpleheaderrow ]
+ bmaobile:simpleheaderc Add as first Subnode :
- 135 bmobile:simplerow Add as last Subnade

+- B bmobile:simplecol {col.
'] bmobile:modal
\[J bmobile:dynmodal

Add as preceding Sidenode *
Add as subsequent Sidenode *

Cut
Copy

Remove

Open all Subnodes

Close all Subnodes
T

D0 X e DO
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E tutonal_main.xml &3

Layout = Prev

-0 natpage
-] bmobile:horizontalbar
[0l bmobile:bartext (Natural for Ajax - Responsive Tut
+{[J] bmaobile: forminline
- [ bmobile:container
=221 bmobile:row
-+ bmobile:col
-~ bmobile:simplegrid (gridlines, 100%)
- 222 bmobile:simpleheaderrow :

+ bEmobile: Add as first Subnode

=133 bmobile:sim Add as last Subnode
+- [ bmobile:

'[J] bmobile:madal i:: as PFECEE*'”E! ils.znndz ;
']l bmobile:dynmodal as subsequent sidenode
Cut
Copy

Paste as preceding Sidenode

Paste as subsequence Sidenode
Remowve

Open all Subnodes

D0 X BEF< DO

Close all Subnodes

Modify the property name so that you have three header columns: Firstname, Lastname, E-Mail.
Press <ctrl s>. In the Layout Area click on the node bmobile:simplecol. The colprop property is
the Natural fieldname for your data column. Change it to firstname.
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3 tutorial_main.xml 52 = B [Properties 5
Layout = Preview
Al Property Value
=@ natpage E v Basic
. - vents
- =1 bmobile:horizontalbar Natural for Ajax - Responsive Tutorial — o firstname
[l bmobile:bartext (Natural for Ajax - Responsive Tut b o S commen it
+ [[] bmobile:forminline aoout j “‘W“‘
isplayon
= [l bmobile:container X Poyony
Show 10 %  entries [ simple Gridcolumn flush
= %2 bmobile:row f lcon Gridcolumn flushmethod
i=f bmobile:col Search: I simple Grid visible
= bmobile:simplegrid (gridiines, 100%) P Simple Header Column ~ Natural
=332 bmobile:simpleheaderrow 334 Simple Header Row njxinatcomment
F bmobile:simpleheadercel (Firstname) Firsthame Lasthame E-Mail 335 simple Row njx:natname
F bmobile:simpleheadercol (Lastname)
+ M bmobile:simpleheadercol (E-Mail .
1o . ° { ) No data available in table
= £ bmobile:simplerow
+ B bmobile:simplecol (firstname)

Copy and paste the bmobile:simplecol twice and change the colprop correspondingly so that you
see:

E tutonal_main.xml 3

Layout =

= IE| natpage
-] bmobile:horizontalbar
[[Il bmobile:bartext (Natural for Ajax - Responsive Tut
+ [ bmobile: forminline
- [[J] bmaobile:container
=222 bmobile:row
-1 bmabile:col
- bmobile:simplegrid (gridlines, 100%)
- 222 bmobile:simpleheaderrow

+- [ bmobile:simpleheadercol {Firstname)
+ [ bmobile:simpleheadercol {Lastname)
+- [ bmobile:simpleheadercol {E-Mail)

- i.2 bmobile:simplerow
+- [ bmobile:simplecol (firstname)
+ [ bmobile:simplecol (lastname)
+ [ bmobile:simplecol {email)

[ I

We now add an additional invisible id column. Drag and drop a Simple Header Column from
the Controls palette and leave the name empty.
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P

ro

Responsive Maps/Charts All P
Mon-Yisual Controls v Bi

Responsive Controls
Responsive Pages
Responsive Container

Responsive Grids
F simple Gridcolumn
El lcon Gridcolumn
B simple Grid

Simple Header Column

la Hazsdar D nasie

EMOEBILE:SIMPLEHEADERCOL

]
3

—Erla o 1
[ I PRl P
[ I PR i P

]
3

Drag and drop a Simple Gridcolumn from the Controls palette and apply the following properties:

] Properties &3

All Property Value
Events v Basic
colprop userid

Props comment

datatype

displayonly

flush

flushmetheod

visible false v
~ Matural

nx:natcomment

njx:natname

Press <ctrl s>. Whenever a layout is saved, the corresponding Natural adapter is updated. We will
now generate a Natural program from the adapter. In Project Explorer right click on TUTMAN-
A.NS8 and select Generate Main Program.
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5 Project Explorer i3 m Matural Mavigator = 0O tutc:nrial_main.xml &
BS V|8 8E| e § et

W @ MaturalAjaxResponsiveTutonal-= natural-runtime (1) = E natpage
& settings L -] bmobile:horizontalbar
w (&= Matural-Libraries
v & NJXTUTOR S >3
@ ERR Open F3
@ RES Open With 3
v (8 SRC _
5 TUTMAMN-A.NSS Show In Alt+Shift+W >
v (2} User-Interface-Components show in Local Terminal » E
v (2 responsive_tutorial
E| C Ctrl+C
= ciscenfig = oFY e . !
(= multilanguage Paste Ctrl+V
= styles I Delete Delete
hd xml Fermove from Context Ctrl+ Alt+Shift+ Down
. E tutlzlrllal_.rnmn.}:r'nl Mark as Landmark Ctrl+Alt+Shift+ Up I
Q «cisapplication
[¥] ciseditorconfigaml SERES
tutorial_main.html Fename... F2
H_I .natl._lr': i=3 Import.
=l -proe
" g Export.
| Refresh F5
MaturalOME *
Code Generation *
Q. Cowverage As ¥
) RunAs »
Uf;: Debug As »
Profile As *
Generate Main Program

In the dialog add TUTMAN-P as Object name and click the OK button.
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Generate Main Program for Adapter X

Generate Main Program for Adapter ‘'TUTMAN-A’ 1
Specify the Matural program you want to generate, N

Project: MaturalAjaxResponsiveTutorial

Library: MEXTUTOR Browse...

Object type:  Program e

Object name: | TUTMAN-P

?ﬁ ] 4 Cancel

Fill some items into your grid. Example code:

1 #I11 (I2)

END-DEFINE

EXPAND ARRAY GRIDLINES TO (1:30)

FOR #I1:=1 TO 30

COMPRESS 'First ' #II INTO GRIDLINES.FIRSTNAME(#II) LEAVING NO

COMPRESS 'Last ' #II INTO GRIDLINES.LASTNAME(#I1) LEAVING NO

COMPRESS 'First.lLast' #II '@email.com' INTO GRIDLINES.EMAIL(#II) LEAVING NO
COMPRESS 'User' #I1 INTO GRIDLINES.USERID(#II) LEAVING NO

END-FOR

PROCESS PAGE USING "TUTMAN-A"

Right click and select Run As > Natural Application

Code Generation »
P Coverage As -]
J RunAs » |n' 1 Matural Application Alt+Shift+X, M
# Debug As ’ Run Configurations...

Profile As T
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SUMMARY

We have developed a data grid with visible and invisible data columns and corresponding header
columns, added the Natural code to fill the grid and ran our main application page.

Adding Responsive Spacing and Visibility

If you look at your running page in the browser, you will notice that some parts of the rendering
do not look good. For instance, there is no space between the application bar and your grid. If you
are not familiar with the Bootstrap grid system, take some minutes to read the chapter Responsive
Pages Basics.

= Adding Vertical Distance
= Adding Horizontal Distance
= Device Dependent Showing/Hiding of Controls

Adding Vertical Distance
Open tutorial_main.xml in Layout Painter. In the Layout Area (left) select the bmobile:container

node. Drag and drop a Vertical Distance control from the Controls palette (right) under the
bmobile:container node as first sub node.
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Controls
Responsive Maps/Charts All

Mon-Visual Contrals

Responsive Controls

[T atert Box

= Button
Checkbox

{* Radiobutton

ﬂ Dateinput2

1 Form Field

A Form Label

| Form Textarea
Form Text Qutput

Dropdown

i
[ |

E
L'_é:l Dropdown Item

[D] Cropdown List

= Dropdown Separator
[D] Cropdown Header
[=H Fixed Combo Box
% Fixed Combo Option
[D] Fixed Combo Group
ﬁ Dynamic Combo Box
=l 1con

Image

[ included HTML

i Vertical Distance

EMOBILEVDIST

In the Properties view click the small button right to the styleclasses property. We will now add
a device dependent vertical distance: For smaller devices we add a smaller distance than for larger

devices. In the dropdown select mt-2 and click the Add button. Now select mt-md-* and press the
Add button.
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{3 *tutorial_main.xml &3
Layout

- [ natpage

+~] bmobile: horizontalbar
- || bmobile:container
1 bmobile:vdist
+221 bmobile:row
[D] bmobile :modal
|] bmobile: dynmodal

Natural for Ajax - Responsive Tutorial

Show| 10 # |entries

Search:

Firstname

No data a

Showing 0

Previg

Lastname E-Mail

ailable in table

= 0
Controls
Responsive Maps/Charts
Non-Visual Controls

Responsive Controls

[ et Box

= Button

| Checkbox

® Radiobutton

ﬁ Dateinput2

1 Form Field

A Form Label

Form Textarea
|;?| Form Text Output

Select styleclasses

Edit field or select from dropdown

x

mt-2

Select class

mt-2

~ Add

mt-1
mt-2
mt-3
mt-4
mt-3
rt-sm-*

mt-lg-* ||
it Cancel

In the field change mt-md-* to mt-md-5 and click the OK button.

O Properties 53

All Property Value
~ Basic
comment
style

styleclasses
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Select styleclasses

Edit field or select from dropdown

mt-2 mt-md-5

Select class

mt-md-*

between 1 and 5

oK

Add

Margin top, medium devices and up - * can be a nurnber

Cancel

What we have done means the following: For all devices we set mt-2 sets a distance of about 8px.
For medium devices and up we overwrite this default setting with mt-5 which sets a distance of

about 48px.

Adding Horizontal Distance

In the Layout Area (left) select the bmobile:col node above the bmobile:simplegrid node. In
Properties view click the small button right to the styleclasses property. We will now apply a
device dependent width and horizontal distance for our grid. Remove the col in the field. In the

dropdown select col-* and click the Add button. In the field modify col-* to col-10.

12
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tutoriaLrnain‘xm| 28
Layout
S]] natpage
+—] bmobile:horizontalbar
- [ bmobile:container
1 bmobile:vdist
=-iiI bmobile:row
bmobile:col
+E= bmobile:simple
[D] bmobile:modal
|| bmobile: dynmodal

= O [O] Properties

ﬂ Simple Gridcolumn
ﬂ lcon Gridcolumn

Search:
FH simple Grid
M simple Header Column
Firstname Lastname E-Mail imple Header Row
imple Row
No data ay=-i-t-—ms-td
Select styleclasses X
Showing (0 Editfield or select from dropdown

Previq [col-10

Select class

col-*

and 12

Column width. All devices, * can be a number between 1

~ Add

In the same way add col-offset-1, col-md-8 and col-offset-md-2.

Preview || contrals
Responsive Maps/Chares Al ProEperty Value
o + Basic
Natural for Ajax - Responsive Tutorial | PP comment
Responsive Pages invisiblemaode
- P Centainer style
Show 10 % entries Respansive Grids P — col
visibleprop

13
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Select styleclasses ot

Edit field or select from dropdown

col-10 offset-1 col-md-8 offset-md-2|

Select class
offset-md-* o Add

Medium devices and up, * can be a number between 1 and
12

QI Cancel

Click the OK button and press <ctrl s>.

What we have done means the following: For all devices our BMOBILE:SIMPLEGRID takes 10 of
the 12 Bootstrap grid columns. We set a horizontal distance of 1 Bootstrap grid column. For medium
devices and up we overwrite this default setting so that our BMOBILE:SIMPLEGRID takes 8 of
the 12 Bootstrap grid columns and has a horizontal distance of 2 Bootstrap grid columns.

Device Dependent Showing/Hiding of Controls

On larger devices you can show more information than on smaller devices. For our application
bar we only want to show the About button and the Help icon for larger devices. This makes sure
that our application bar is not “wrapped”.

In the Layout Area (left) select the bmobile:forminline node. Apply the styleclasses d-none d-md-
block.
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E‘tutorialimain.xm\ =
Layout
- [@] natpage
=71 bmobile:horizontalbar
[C] bmobile:bartext (Na
+ [ bmobile: forminline
- [ bmabile:container
1 bmobile:vdist
=221 bmobile:row
=i bmobile:col
+-[] bmobile:simple
[ bmobile:modal
[ bmobile:dynmadal

Preview

£ || Controls

Natural for Ajax - Responsive Tutorial

Show 10 4

entries

Responsive Maps/Charts Al

Men-Visual Cantrols

Responsive Controls

Responsive Pages

Responsive Container

Responsive Grids

B [ Properties i1
Property Value
B w Basic
comment
displayonly
invisiblemode

style

Search:
Firstname Las

No data a

Showing 0

Previq

Select styleclasses

Edit field or select frem dropdown

*

l-nene d-md-block

Select class
d-none d-md-block

Wisible only on medium devices and up

Add

Cancel

styleclasses d-none d-md-block
visibleprop
w Miscellaneous

n testtoolid

Now the BMOBILE :FORMINLINE container with its sub controls is only shown for medium

devices and up.

Be sure you pressed <ctrl s>. Run your TUTMAN-P program, resize your browser window and

see how the rendering adapts to the size of the browser window.

SUMMARY

We have applied device dependent spaces (vertical and horizontal) and device dependent show-
ing/hiding of controls by simply applying css styleclasses to our layout.
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PART2: Develop the Pop-Up Page

In this part we will develop a page with a responsive form. We will prepare everything so that
we can open the page also as a pop-up from our main application page.

Create a Responsive Form

In the File menu click New > User Interface Component, select the Natural Responsive Page -
Plain template and enter layout and adapter name as shown below.

workspace_responsive_tutorial - Software AG Designer
File Edit Mavigate Search Project Run  Window Help

MNew Alt+Shift+N > 5| Predict Components Folder
Open File... =% Matural Project
[y Open Projects from File System... &= Matural Library
Recent Files > ™ Project.
Close Editor Ctrl+W  ff  Program
Close All Editors Ctrl+Shift+W Subprogram
Save Ctrl+S ﬁ Subroutine
Save As ﬁ Function
rl_l
Save Al Ctreshiftes | B Copycode
Revert 72l Helproutine
E.?E Text
Move... 3{ Global Data Area
] Rename.. F2 3£ Local Data Area
]
#] Refresh Fs E: Parameter Data Area
Convert Line Delimiters To ¥ | =
=8 Map
Print.. Ctd+P | 9¥ DDM
o Import | Error Meszage
4 Export.. |5 Page Layout
(2l User Interface Component
Properties Alt+Enter B Style Sheet
Switch Workspace > [l Responsive Style Sheet
Restart M.  Object Using Construct Model
Exit
I ™ Example...
™ Other... Ctrl+M
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| Mew Ajax Page Layout
I] Mew Ajax Page Lay O x

Create a Ajax Page Layout

Select a user interface component.

User interface component: | /MaturalAjaxResponsiveTutorial/User-Interface-Components/responsive_tutorial | Browse...
Page layout: | tutorial_popup |
Matural adapter: | TUTPOP-A |

Matural Page Workplace Standard Pop-up Dialogs  PDF Output  HTML Page
"

Matural Mon-Responsive Page
[@ Natural P g

% Natural |Matural Responsive Page - Plain
Mohile

[ Mlatiiral Baermanenis Dane - Sidakhar )

®

Click the Finish button. Drag and drop a Form container from the Controls palette (right) under
the bmobile:container node.
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[ tutorial_popup.xml 22 = g
Layout = Preview 5 || Controls
Responsive Maps/Charts
- E natpage 55 ! Mon-Wisual Contrals
-+ [D] bmobile:container Responsive Controls
[[I] bmobile:dynmodal Responsive Pages
Responsive Container
[D] Container
[D] Sidebar Container
[[] sidebar

[D] Sidebar Group

[D] Content of SIDEBARCOR
Calumn

il Row

[D] Farm

[D] Farm Area

I o si0BLEFORN |

[D] Form Graup

We want a little bit spacing left and right of our form. In the Properties view set mx-3 as styleclasses
as described in PART1 of this tutorial. The “x” stands for “left and right”.

Drag and drop a Vertical Distance control from the Responsive Grids section of the Controls
palette (right) under the bmobile:container node as first sub node. In the Properties view set mt-
3 as styleclasses.

E“tutorial_popup.xml s = B [ Properties &1
Layout = Preview Controls
= > All Property Value
Responsive Maps/Charts
=@l natpage anaman . . - o= = nn w Basic
= [D] bmobile:container Responsive Controls comment
1 bmobile:vdist Responsive Pages style
. Responsive Container leclasses mt-3
=[] bmobile: form sty L]
R m-l Tantainar

¢ Tip: Don't forget to press <ctrl s> after changes to refresh the Preview Area (middle).

A Form is a container for different types of input elements, such as: text fields, checkboxes, radio
buttons, submit buttons, etc. Use Form Group containers inside a form to get some grouping of
labels, inputs, validation etc.

Drag and drop a Form Group container from the Controls palette (right) under the bmobile:form
node.
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[F8 *tutorial_popupxml &

Layout = Preview

- natpage
=[] bmobile:container
1 bmobile:vdist
- [0 bmobile: form
[[J] bmobile:dynmodal

= B8 [ Prop
Controls
Responsive Maps/Charts

All

Mon-Visual Centrols Props
Responsive Contrals

Responsive Pages
Responsive Container

[D] Container

[D] Sidebar Container

[[J] sidebar

[D] Sidebar Group

[D] Content of SIDEBARCOM
Column

ZiZ Row

[D] Farm

[D] Form Area
[D] Form Inline
[D] Form Group

[D] Panel

[[] Panel § BMOBILE:FORMGROUP |

On larger devices we want to render the label and the input control for a value side by side. For
smaller devices we want to render the label above the input control. To do so we set the property
renderasrow to true. Then we can use the Bootstrap grid system with its col* classes to define
when to render side-by-side and when to break the row.

Drag and drop a Form Label control from the Controls palette (right) under the bmobile:formgroup

node.

Controls
Responsive Maps/Charts
Mon-Visual Controls

Responsive Controls

=
=
]
=1
m
=

Button
Checkbox
Radiobutton
Dateinput2
Form Field
Form Label

=T E K[

3
nomn

Farm Textarea

EMOBILE:FLABEL

Farm 7

Dropdown
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Drag and drop a Column container from the Controls palette (right) under the bmobile:formgroup
node — after the bmobile:flabel node.

| | Controls

Responsive Maps/Charts
Mon-Visual Controls
Responsive Controls
Responsive Pages

Responsive Container

[D] Container

[D] Sidebar Container

[ sidebar

[D] Sidebar Group

[D] Content of SIDEBARCOD
Column

=== Row
[D] For| BMOEBILE:COL

[D] Form Area

Drag and drop a Form Field control from the Controls palette (right) under the bmobile:col node.

Controls
Responsive Maps/Charts
Mon-Yisual Controls

Responsive Controls

=
I
m
a3
m
=

Button

Checkbox
Radiobutton
Dateinput2

Form Field

Form Label

Form BMOBILE:FFIELD

Form Text Qutput

| 00 = >l @ [

Select the bmobile:flabel node. In the Properties view apply Firstname for the name property.
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Select the bmobile:ffield node. In the Properties view apply firstname for the valueprop property.
This will be the name used for the corresponding Natural field. It must start with a lower-case
character, but in your Natural program the field will be upper-case.

Select the bmobile:flabel node. In the Properties view apply col-12 col-sm-2 for the styleclasses

property. This means: It should span the complete row on very small devices. But it should only
span 2 columns on a little bit larger devices and up.

3 *tutorial_popup.xml 52

= B [ Properties 2
Layout = Praview B controls
Responsive Maps/Charts Al Property Value
= (@ natpage Non-Visual Controls Props ¥ Appearance
= [D] bmobile:container Responsive Controls invisiblemode
1 bmobile:vdist | el [ atert Box straighttext
=[] bmobile: form = Buttan Zg:e I ol12 colemed o
eclasses - -sm-
= [D] bmobile: formgroup Checkbox title
A bmobile:flabel (Firstname) % Radiobutton titlestraighttext
=11 bmobile: col 1_ Dateinput2 « Basic
Form Field
1 bmobile: ffield (firstname) A comment

Select the bmobile:flabel node. In the Properties view apply col-12 col-sm-10 for the styleclasses

property. This means: It should span the complete row on very small devices. But it should only
span 10 columns on a little bit larger devices and up.

5 tutorial_popup.xml 52

~ O [C] Properties 52
Layout = Preview {9 Contrals
Responsive Maps/Charts | All P'”“'_w Value
* [ natpage Non-Visual Contrals Props v Basic
=[] bmobile: container Firstname Responsive Controls comment
1 bmobile:vdist - [ Atert Box invisiblemode
=[] bmobile:form : = Butten g:i I s e
: eclasses cal-12 col-sm-
EHHl bmobde:formgrosp @ [M]|  ‘Clessssssssscsscssscscescssccsssssssccssessssnsencess Checkbox

A bmobile:flabel (Firstname)
="} bmobile:col
1= bmobile:ffield (firstname)

@ Radiobutton
Z Dateinput2
=1 Form Field

visibleprop

A Form Label

With this on a little bit larger devices, our form-group will be rendered in one row and on very
small devices our form-group will break into two rows. Resize your Preview Area to see this effect.

Preview |
Firstname ! ;
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Preview

In the same way add three more form groups. You can copy and paste the complete

Firstname

bmobile:formgroup node and adapt it correspondingly.
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Z tutonal_popup.xml 3
Layout =

- natpage
-] bmobile:container
1 bmobile:vdist
-] bmobile: form
- [ bmobile: formgroup
A bmobile:flabel (Firstname)
-+ bmobile:col
[ bmobile: ffield (firstname)
[0l bmobile: formgroup
A bmobile:flabel (Lastname)
-+ bmobile:col
[ bmobile: ffield (lastname)
[0l bmobile: formgroup
A bmobile:flabel (E-Mail)
-1 bmobile:col
[ bmobile: ffield (email)
[0l bmobile: formgroup
A bmobile:flabel (Userid)
-1 bmobile:col
[ bmobile: ffield (userid)

Add Placeholders, Validators and Displayonly Behavior

We want our firstname and lastname to be mandatory. Select the corresponding bmobile:ffield
nodes. In Properties view set the property required to true.

Our userid should be displayonly. Select the corresponding bmobile:ffield node. In Properties
view set the property displayonly to true.
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We want that our email is validated for valid email values. Select the corresponding bmobile:ffield
node. In Properties view set the property email to true.

For empty fields we want to show a placeholder text. For the bmobile:ffield nodes of firstname,
lastname and email, set the property placeholder to Your firstname, Your lastname, Optional:
Your E-Mail.

Add Submit and Cancel Button

Add another Form Group as last sub node of our bmobile:form node. This will contain our buttons.
Add a Vertical Distance before our new bmobile:formgroup node and set the styleclasses property
to mt-1. We want just a little bit space between our fields and the buttons.

Add a Column as sub node of the new bmobile:formgroup and set the styleclasses property to
mx-auto. We want our buttons to be centered.

Add a Button under the bmobile:col node and set the following properties:
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] Properties &3

All Property

Events v Ap

Props

pearance
invisiblemode
straighttext
style
styleclasses
titlestraighttext

w Basic

comment
helpid

name
renderasicon
renderaslink
textid

title

type

~ Binding

method
nameprop
titleprop
visibleprop

w Miscellaneous

testtoohid

Yalue

btn-primary

Save

onSave

The method is the name of the event, which will be forwarded to your Natural program when the
button is clicked. Add a second Button under the bmobile:col node as last sub node and set the

following properties:
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[ | Properties 53

All

Ewvents

Props

Property Value

v Appearance

invisiblemode

straighttext

style

styleclasses btn-default
titlestraighttext

s Basic

comment

helpid

namme Cancel
renderasicon

renderaslink

textid

title

type button|

w Binding

method onCancel
nameprop

titleprop

visibleprop

w PMiscellaneous

testtoolid

Be sure to set the property type to button. In difference to submit buttons (=default) this button
will not validate the form. This allows you to close the pop-up even in case of invalid field values.

128

Natural for Ajax



PART2: Develop the Pop-Up Page

Running a Quick Test

From the generated adapter TUTPOP-A you can simply generate a Natural program and run the
generated program — without any modifications. In PART3 of this tutorial we will integrate the

form as pop-up into our main application.

5 Project Explorer 52 M Natural Navigator = O
BESTVIH8B|e 8
v '[;ﬂ MaturalAjaxResponsiveTutonal-= natural-runtime (1)
[= .settings :
v B2 Natural-Libraries Generate Main Program for Adapter x
w [ NIXTUTOR
2 ERR Generate Main Program for Adapter ‘'TUTPOP-A’ 1
& RES Specify the Natural program you want to generate, N
w (8 SRC
o TUTMAN-A.NSB
Ef TUTMAN-P.MSP| Project: aturalfjaxResponsiveTutoria
i Proj M |AjaxResp Ti I
| TUTPOP-A.NSE
X Library: | NUXTUTOR | | Browse..
(E User-Interface-Componet
yel natural Object type: | Program V
Wl -project
Object name: | TEST-P| |
SUMMARY

We have created a responsive form with several fields, added validation and responsive rendering
and we added a submit and a cancel button to the form. We generated a Natural program for it

and could run it immediately without any programming.
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= Create the Natural Subprogram for the tutorial_popup Page ............ccooiiiiiiiiiiiieiiiiiiecee e 132
= Add Controls to Open the Pop-Up (tutorial_main) .............cooiiiiiiiiiii e 133
= Adapt the Natural code (TUTMAIN-P) .....ooriiii e 137
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We will now open our tutorial_popup page (PART2) from our tutorial_main page (PART1). We

will create a Natural subprogram for our pop-up. When our TUTMAIN-P receives a specific event

—an icon is clicked - it will call the Natural subprogram. This will open the pop-up window.

Create the Natural Subprogram for the tutorial_popup Page

Right click on the TUTPOP-A adapter and select Generate Main Program. In the opened dialog
select Subprogram and enter TUTPOP-N as Object name.

Project:
Library:
Object type:

Object name:

'
@

Generate Main Program for Adapter

Generate Main Program for Adapter 'TUTPOP-A’

Specify the Matural program you want to generate,

Matural&jaxResponsiveTutorial
MEXTUTOR Browse...
Subprogram e
TUTPOP-N|
aK Cancel

We want to pass all values from our TUTMAIN-P program. To do so, apply the code in bold:

DEFINE DATA PARAMETER
1 P_EMAIL (A) DYNAMIC
1 P_FIRSTNAME (A) DYNAMIC
1 P_LASTNAME (A) DYNAMIC
1 P_USERID (A) DYNAMIC

LOCAL

ND-DEFINE

¥ MM = s

ALERTTEXT (A) DYNAMIC
ALERTTYPE (A) DYNAMIC
EMATL (A) DYNAMIC
FIRSTNAME (A) DYNAMIC
LASTNAME (A) DYNAMIC
USERID (A) DYNAMIC

132
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EMAIL:=P_EMAIL
FIRSTNAME :=P_FIRSTNAME
LASTNAME : =P_LASTNAME
USERID:=P_USERID

*

We want that our tutorial_popup page is opened as pop-up (modal). To do so, apply the code in
bold:

PROCESS PAGE MODAL
PROCESS PAGE USING "TUTPOP-A"

END-PROCESS
END

We want to close the pop-up when our Cancel button is clicked. When our Save button is clicked,
we want to pass back the changed values. To do so, apply the code in bold:

VALUE U'onCancel'

IGNORE

VALUE U'onSave'
P_EMATL:=EMAIL
P_FIRSTNAME :=FIRSTNAME
P_LASTNAME :=LASTNAME
P_USERID:=USERID

PROCESS PAGE UPDATE FULL

Add Controls to Open the Pop-Up (tutorial_main)

Open the tutorial_main.xml layout in Layout Painter. We will now add an icon column to our
grid. When the icon is clicked, we want to pass an event to our Natural program so that it can
open the pop-up.

= Add an Icon Grid Column Control (BMOBILE:ICONCOL)
= Add a Natural Event Data Control (NJX:EVENTDATA)
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= Add an Open Popup Features Control (XCIEVENTDATA.XCIINDEX)
Add an Icon Grid Column Control (BMOBILE:ICONCOL)

In the Layout Area (left) select the bmobile:simpleheaderrow node. From the Controls palette
(right) drag and drop a Simple Header Column as first sub node of the bmobile:simpleheaderrow.

From the Controls palette (right) drag and drop an Icon Grid Column as first sub node of the
bmobile:simplerow.

Controls
Responsive Maps/Charts All
Mon-Visual Centrols Events

Responsive Controls

: Props
Responsive Pages
Responsive Container

Responsive Grids
Simple Gridcolumn

lcan Gridcalummn

Simple Grid
BMOBILE:ICONCOL

' [l =0

Simple H

Simple Header Row

—lwla B 1o
- e =B i
[ [Ny RN B M

Simple Row

In Properties view click on the small button right of the iconurl property. In the opened dialog
click the SVG Icons button and select the pencil-fill.svg icon.
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= B [ Properties i3 i
7 || Controls
Prope Value
T Responsive Maps/Charts All perty
Maon-Yisual Controls Events v Basic
Responsive Controls comment
_ Props :
Responsive Pages iconurl
Responsive Container ic.:,nuﬂpr.:,p
Responsive Grids iicihlemnde
Simple Gri Enter Image URL X

lcon Gridd

Simple Gril Enter the URL
simple He| ©F select an 5VG icon from the Bootstrap lcons library
or Browse to select an image

o [l cn e

Simple He

T Ty
[ Ny
I T

Simple Ro | |

K Cancel SVG lcons Browse

Set the following method and styleclasses property values:

] Properties 53 AlET o 8 -
All Property Value
Events v Basic
comment
Props iconurl W HTMLBasedGUI/bootstrapicons/icons/pencil-fill.svg
iconurlprop

invisiblemode

method
style

styleclasses ml-2 icon-svg-primary

The event onEditItem will be sent to our Natural program when the icon is clicked. The styleclass
ml-2 adds some space left of the icon. This is important for small devices because on small devices
a plus icon to see all columna is automatically shown. The ml-2 styleclass makes sure that there
is enough space between our pencil icon and the plus icon.
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Firsthame Lastname

©® .# Firstl Last1

The icon-svg-primary styleclass renders our pencil in our primary color (blue).
Add a Natural Event Data Control (NJX:EVENTDATA)

When our icon is clicked, we want to automatically know the index of the item for which the icon
is clicked. To get this support, drag and drop a Natural Event Data control as sub node of the
natpage node.

Controls

Responsive Maps/Charts All
Mon-Visual Controls Eve

E Autocomplete Addon Pro
E’ﬁ_}- Timer

|| Data Definition

[ ] %o Context

Report2

Trigger Matural Event

E Session Parameters

| | Request Context

| | Matural Objects

'ﬁ'n Matural Event Data

| | Open Pg

MNIEVENTDATA

This is an invisible control. It generates Natural fields which will tell us the index of the item for
which the icon is clicked.
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Add an Open Popup Features Control (XCIEVENTDATA.XCIINDEX)

Drag and drop an Open Popup Features control as sub node of the natpage node.

Controls
Responsive Maps/Charts All

Mon-VWisual Controls

E Autocomplete Addon
% Timer

|| Data Definition

[ ] %ol Context

Report2

Trigger Matural Event
E Session Parameters

| | Reguest Context

|| Matural Objects

ﬁ'n Matural Event Data

| | Open Popup Features

MNIXCIOPENPOPUP

This is an invisible control. It generates Natural fields which allow us to set the title, height, width,
etc. of the pop-up dynamically at runtime. Be sure that you saved your layout (<ctrl-s>).

Adapt the Natural code (TUTMAIN-P)

We now adapt our TUTMAN-P to initialize the pop-up and call our subprogram TUTPOP-N.

= Adapt the TUTMAN-P to the Added Controls
= |nitialize the Pop-Up
= Call the Natural Subprogram (TUTPOP-N)
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= Run your Application
Adapt the TUTMAN-P to the Added Controls

Double-click the file TUTMAN-P. It will open in the Natural editor. You see that it has errors. In
the editor select TUTMAN-A and press F3.

%

PROCESS PAGE USING " -A"
%

This will open the TUTMAN-A adapter in the Natural editor. You see that in the adapter some
additional fields exist. The reason is that for the Natural Event Data and the Open Popup Features
controls additional Natural fields were generated. We need to adapt our program. Select all the
fields in the adapter.

-~ DEFINE DATA PARAMETER
/*( PARAMETER

11 GRIDLINES (1:%)

EMAIL (A) DYNAMIC

b

2 FIRSTNAME (A) DYNAMIC
2 LASTNAME (A) DYNAMIC
2 USERID (A) DYNAMIC
El1 XCIEVENTDATA
2 XCIINDEX (I4)
El1 XCIOPENPOPUP
2 FEATURES (A) DYNAMIC
2 HEIGHT (I4)
2 LEFT (I4)
2 POPUPTYPE (A) DYNAMIC
2 TITLE (A) DYNAMIC
2 TOPPOS (I4)
2 WIDTH (I4)
/*) END-PARAMETER
END-DEFINE
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In the Natural program replace the old fields with these new fields. Also copy the lines for the
onEditltem event. Your code should look like this:

DEFINE DATA LOCAL

1 GRIDLINES (1:%*)

2 EMATL (A) DYNAMIC

2 FIRSTNAME (A) DYNAMIC
2 LASTNAME (A) DYNAMIC
2 USERID (A) DYNAMIC

1 XCIEVENTDATA

2 XCIINDEX (I4)

1 XCIOPENPOPUP

2 FEATURES (A) DYNAMIC
2 HEIGHT (I4)

2 LEFT (I4)

2 POPUPTYPE (A) DYNAMIC
2 TITLE (A) DYNAMIC

2 TOPPOS (I4)

2 WIDTH (I4)

1 #IT (I2)

END-DEFINE

EXPAND ARRAY GRIDLINES TO (1:30)

FOR #II1:=1 TO 30

COMPRESS 'First " #II INTO GRIDLINES.FIRSTNAME(4#II) LEAVING NO

COMPRESS 'Last ' #II INTO GRIDLINES.LASTNAME(4II) LEAVING NO

COMPRESS 'First'#I1 '.lLast' #II '@email.com' INTO GRIDLINES.EMAIL(4#II) LEAVING NO
COMPRESS 'User' 4II INTO GRIDLINES.USERID(#II) LEAVING NO

END-FOR

*

PROCESS PAGE USING "TUTMAN-A"
*

DECIDE ON FIRST *PAGE-EVENT
VALUE U'nat:page.end', U'nat:browser.end’
/* Page closed.

IGNORE

VALUE U'gridlines.onEditItem’
PROCESS PAGE UPDATE FULL

NONE VALUE

/* Unhandled events.

PROCESS PAGE UPDATE
END-DECIDE

*

END
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Initialize the Pop-Up

We want to set a title for our pop-up. We also want to specify the pop-up size when it is opened.
Add the following code to your Natural program before the PROCESS PAGE statement:

XCIOPENPOPUP.TITLE:="Edit User Information'
XCIOPENPOPUP.FEATURES:="sizetocontent:true’

*

PROCESS PAGE USING "TUTMAN-A"

In the XCIOPENPOPUP.FEATURES field you can set several features — like height width,
whether a close button should appear etc, - separated be a semicolon. We just set one feature
(sizetocontent) which means that if possible our pop-up should automatically adapt to the size of
the opened page (tutorial_popup).

The last setting we need to add is just a technical one: In the XCIOPENPOPUP.POPUPTYPE we
need to set the opened popup should be rendered using the responsive controls set (bmobile:*).
Add the line in bold:

XCIOPENPOPUP.TITLE:='Edit User Information'
XCIOPENPOPUP.FEATURES:="sizetocontent:true'
XCIOPENPOPUP.POPUPTYPE:='"BMPOPUP'

*

PROCESS PAGE USING "TUTMAN-A"

Call the Natural Subprogram (TUTPOP-N)

When our new icon is clicked, we will receive the event gridlines.onEditItem. The field XCIINDEX
will contain the index of the item, for which the icon is clicked. Add the line in bold:

VALUE U'gridlines.onEditItem'

CALLNAT "TUTPOP-N' EMAIL(XCIINDEX) FIRSTNAME(XCIINDEX) LASTNAME(XCIINDEX) <
USERID(XCIINDEX)

PROCESS PAGE UPDATE FULL

Don't forget to press <ctrl-s>.
Run your Application

Right-click on TUTMAIN-P and select Run As > Natural Application.
SUMMARY

We have added an BMOBILE:ICON, an NJX:XCIOPENPOPUP and NJX:EVENTDATA control to
the tutorial_main page. We have initialized the XCIOPENPOPUP fields for opening the pop-up.
We have called our TUTPOP-N subprogram and passed the data of the selected item. We used
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the XCIEVENTDATA XCIINDEX field to know which item was clicked. We could run the completed
application immediately.
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20 Tutorial Reference Implementation

The application built in this tutorial is available as reference implementation. You can install it
from the Welcome page of your NaturalONE installation.
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IV First Steps Java Pages

This documentation is organized under the following headings:

About this Tutorial

How the completed “Hello World!” application will appear to the user.
An overview of the basic steps that are required to create this application.

Starting the Development
Workplace

How to start the development workplace.

Creating a Project

How to create the project that is to be used for this tutorial.

Getting Started with the Layout
Painter

How to create a layout for your project. General information on how to
use the Layout Painter.

Writing the GUI Layout

How to use the Layout Painter in order to create the GUI layout for the
“Hello World!” application.

Setting Up Your Environment

How to set up Application Designer in your development environment
for Java.

Writing the Adapter Code

How to define the class and how to use the Code Assistant in order to
generate most of the adapter code. How to program the adapter code for
the method using your development environment for Java and how to
test the completed application. How to view the generated HTML page
directly from the browser.

Some Background Information

Information on changing the adapter code. About name binding between
controls and adapter, data exchange at runtime, and files and their
locations. Some information for real development and on some tools
provided in the development workspace.

It is important that you work through the exercises in the same sequence as they appear in this
tutorial. Problems may occur if you skip an exercise.
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21 About this Tutorial

This tutorial provides an introduction to working with Application Designer's development
workplace. It explains how to create a “Hello World!” application. This covers all basic steps you
have to perform when creating pages with Application Designer: you create a layout file, you
create an adapter class, and you run the application. This is about eighty percent of all you need
to know. The remainder of the Application Designer documentation contains just details and some
more sophisticated techniques, such as navigating between pages.

When you have completed all steps of this tutorial, the page for your “Hello World!” application
will look as follows:
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(Preview &
‘Hello World! X

Say Hello

Input Area -
Your Marme | |
‘output Area
Result | |

Input your name and press the 'Say Hello' button,

Your application will act in the following way: When you enter a name in the Your Name field
and choose the Say Hello button, the Result field displays "Hello World" and the name you have
entered.

To reach this goal, you will proceed as follows:

1. You will first create a new Application Designer project.

2. You will then use Application Designer's Layout Painter to create the following layout:
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-1 |page
- [T titlebar (Hello Woaorld!)
- [ header
= button (Say Hella)
- pagebody

=FIIlitr
=+ hdist (100%.)
2] icon
=" rowarea (Input Area)

- Lilitr
A label (Your Nare, 100)
I field (name, 200)
=" rowarea (Output Area)
=Ll
A label (Result, 100}
T field (result, 200}

1 wvdist (100)
LIt
A label (Input your name and press the 'Say Hello' button.)

L statushar
This corresponds to the following XML layout:

<?xml version="1.0" encoding="UTF-8"7>
<page model="DummyAdapter">
<titlebar name="Hello World!">
</titlebar>
<header withdistance="false">
<button name="Say Hello" method="sayHello">
</button>
<{/header>
<pagebody>
<tr takefullwidth="true">
<hdist width="100%">
</hdist>
<icon image="../cisdemos/images/hello.gif">
</icon>
</itr>
<rowarea name="Input Area">
<Gtr>
<Tabel name="Your name" width="100">
</label>
<field valueprop="name" width="200">
</field>
</litrd
{/rowarea>
<rowarea name="Qutput Area">
<Gtr>
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<label name="Result" width="100">
</label>
<field valueprop="result" width="200" displayonly="true">
</field>
</itr>
</rowarea>
<vdist pixelheight="100">
</vdist>
<Gtr>
<label name="Input your name and press the &apos;Say Hello&apos;
button." asplaintext="true">
</label>
</itr>
</pagebody>
{statusbar withdistance="false">
<{/statusbar>
</page>

3. When you save your layout for the first time, an intelligent HTML page is generated.

4. Before you can start coding, you have to make specific definitions in Application Designer and
in your development environment for Java (for example, Eclipse).

5. You will use Application Designer's Code Assistant to generate most of the adapter code.

6. You will then switch to your development environment in order to program the adapter code
for the method sayHe110 which will be executed when you choose the Say Hello button of your
application.

You can now proceed with your first exercise: Starting the Development Workplace.
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22 Starting the Development Workplace

This tutorial assumes that you are using the Tomcat servlet engine which comes with this install-
ation.

~ To start the development workplace

»  Invoke your browser and start the development workplace with the following URL:

http://1ocalhost:51000/cis/HTMLBasedGUI/workplace/ide.htm]

] Note: If you have defined another port number during installation, enter this port
number instead of the default port number 51000.

The development workplace is now shown in your browser.
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' M
f. Development Workplace Application Designer

00 IEE

| Tools & Documentation E

=1 Development Tools
Tl Project Manager
m Layout Managsr
] Style Sheet Editar
B Languags Manager
B2 Literal Translator
B WAR Packager
¥ Control Editar

] Manitaring
B Layaut Chack
= C1 Parformance Tools APPLICATION DESIGHNER
7] Start/Stap Trace
=| Exscute Trace
=12 Dl.-uulnfp-ur Dun.l”“""“_ Copyright @ 2005 - 2008 Software AG, Darmatadt, Germany
E onling Documentation and/or Softeare &G US4, Inc., Reston, VA, Unsted States of Amernca,
EJ-!\-‘G APT andfor thedr suppliers.

= Control Refersnce AN rightx revervesd.

= ] Licenss Informaticn
B License
=1 special Tooks
B unicode Transier
cisdemas

HTMLBazedGUL

You can now proceed with the next exercise: Creating a Project.
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23 Creating a Project

In the Application Designer environment, layouts and classes are structured in so-called application
projects. In the development workplace, you see the existing projects on the left. For each project,
there is a tree of layout definitions that you can display when you choose the button containing
the project name. For example:

Tools & Docurnentation

cisdemos

D Mew Layout,.. i‘

Refresh Yiew

3 Preferences

- [:I Lavouts
=[] (default package)

13_AsciiProtocol
13_DynamicPopupField
13_IconsInTextgrid
13_RowDvynavisCheck
14 Ahsaolutefrea

For this tutorial, you will now create a project with the name "cisyourfirstproject".

~ To create a project

1 Choose Tools & Documentation to display the list of development tools.

2 Choose Project Manager in the tree.

A list of existing application projects is now shown on the right.

3  Choose the New button which is located below the list of application projects.

The following is now shown:
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Create Mew Application Project -
Application Project

Create

Please note: you have to create a context root inside your servlet
engine! The name of the context root is the name of the application
project. In the native Application Designer environment this is done
autormatically by restarting the Server,

4  Enter "cisyourfirstproject" as the name of your project and choose the Create button.
Your new project is now shown in the list of existing application projects on the right.

The left side, which shows buttons for all existing projects, now also shows a button for your
new project.

You can now proceed with the next exercise: Getting Started with the Layout Painter.
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B Creating @ NEW LaYOUL .........ooiiiiii it 156
= Elements of the Layout Painter SCreeN .........c..vviiiiiiiici e 157
B PrevieWing the LAYOUL ...t e e 158
B VIEWING the XML COUE ...t 159
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Getting Started with the Layout Painter

The Layout Painter, which can be accessed from the development workplace, is used to write the
page layout. This is an Application Designer application itself.

Creating a New Layout

You will now create a layout which is stored in the project you have previously created.

~ To choose a layout template

1 Choose the button for the project cisyourfirstproject.

The list of layout nodes inside the tree will be empty at the beginning:

cisyourfirstproject

[ Mew Layout..,
Refresh Wiew
{7 Preferences
-] Layouts
- [C]idefault package)

2 Choose New Layout... in the tree.

The following dialog appears.

Mame hew 1.xml

-- Webpage Dialog

Online Help
Popup

Absence
Request

HTML Page

1)
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3  Enter "helloworld.xml" in the Name field.

This is the name of your layout definition.

4  Select the first template (wWhen you move the mouse over this template, the tool tip "HTML
Page" appears).

The main screen of the Layout Painter appears:

Layout: helloworld.xml =
i Homee Edit Insert Tools Extensions hﬂ | = |
I___ Hew Form ¥ | 4 Cpen ¥ Protocal = Lag = HML Echerna [H5D)
El Sava b 7 Sereer Log Prefarences =
Fila Lo Configuration
Previcwr m Controls
o Pags
o = Title B -
+ = titlabar (Template Lt e Ear ]
+ F haader | Page Header
+ ] pagebody [ Pags Body
e Statusbar G Status Bar
f Ii Status Bar Sub Ses
| | xl=§

f 1 i E = poukle Line Manu

= Tab Strip Selecion
Tab Selaction

% Tirmer

|| Internal Popup Pag

Container
Contrals
Gri_d:.l'Tr\ee:
J Wab 2.0 f Mashup
L1 Advanced

Note: The file helloworld.xml is stored in the /xml directory of your project.
yory proj

Elements of the Layout Painter Screen

The Layout Painter screen is divided into several areas:

* Layout Area (left side)
This area consists of a layout tree and a properties area.
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The layout tree contains the controls that represent the XML layout definition. You drag these
controls from the controls palette into the layout tree. Each node in the layout tree represents
an XML tag.

In the properties area below the layout tree, you specify the properties for the control which is
currently selected in the layout tree.

® Preview Area (middle)
The preview area shows the HTML page which is created using the controls in the layout area.
This page is refreshed each time, you choose the preview button (see below).

The Code Assistant, which will also be used in this tutorial, is also shown in the preview area.

® Controls Palette (right side)
Each control is represented by an icon. A tool tip is also provided which appears when you
move the mouse pointer over the control. This tool tip also displays the XML tag which will be
used in the XML layout.

The palette is structured into sections, where each section represents a certain type of controls.

Previewing the Layout

The layout tree inside the Layout Painter already contains some nodes that were copied from the
template that you chose in the dialog in which you specified the name of the page. To see what
the page looks like, preview the layout as described below.

> To preview the layout
s Choose the following button which is shown at the top of the Layout Painter.
&

The preview area is updated and you see the page. The page already contains a title bar, a
header containing a Save button, the page body and a status bar.

158 Natural for Ajax



Getting Started with the Layout Painter

Template X

Save

The preview area is a sensitive area. When you select a control in the preview area (for example,
the title bar), this control is automatically selected in the layout tree.

Viewing the XML Code

When creating the layout, you can view the currently defined XML code.

> To view the XML code

= From the Edit tab of the Layout Painter, choose XML.

A dialog box appears. At this stage of the tutorial, it contains the following XML layout
definition for the nodes which were copied from the template.

<page model="DummyAdapter">

<titlebar name="Template">

</titlebar>

<header withdistance="false">
<putton name="Save">
</button>

</header>

<pagebody>

</pagebody>
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{statusbar withdistance="false">
{/statusbar>
</page>

You can now proceed with the next exercise: Writing the GUI Layout.
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= Specifying @ Name for the Title Bar ...........oooiiiiiiiii e 162
B Using the Property EQIOr ..o 163
= Specifying @ Name and Method for the BULON ...........c.eoiiiiiiiii e 165
® Adding the INPUt and OUIPUL ATBAS .......eeiiee oottt e e e e e e e 165
Lo o 1T IR T [ =0T PP PPPPPPP 168
= Adding @ HOrzontal DISTANCE ..........ooiiiiiiiii i 169
B Adding an INSLrUCHONAI TEXE ......uuuiiitiiitiiiiiieii e e nnnnnne 170
® Adding @ VErtical DISTANCE ..o 170
B SAVING YOUE LAYOUL ...ttt ettt 171
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You will now create the layout for your “Hello World!” application. When you have completed
all exercises in this chapter, the layout should look as shown below and the XML code should be
the same as shown in the section About this Tutorial.

[ Ipage
- [ ttebar (Hello Warld!)
- header
= button (Say Hello)
-] pagebaody
LIt
=+ hdist {100%)
=l icon
=" rowarea (Input Area)
- Lititr
A label (Your Name, 100)
T field (name, 200)
- rowarea (Output Area)
|
A label (Result, 1007
I field (result, 200}
1 wdist (100)
=FIIlitr
A label (Input your name and press the 'Say Hello' button )
[ | statusbar

@  Tip: Preview the layout and view the XML code each time you have completed an exercise.

If the system finds some wrong or missing definitions while generating the preview page,
there will be a corresponding message in the status bar. From the Home tab of the Layout
Painter, choose Protocol to get more information about these problems.

Specifying a Name for the Title Bar

You will now specity the string "Hello World!" which is to appear in the title bar of your application.

~ To specify the name for the title bar

1  Inthe layout tree, select the node titlebar (Template).

The properties for this control are now shown in the properties area at the bottom. You can
see the default entry "Template" for the name property.

2 Specify the following property:
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Property | Value

name |Hello World!

When you click on the layout tree, the node in the layout tree changes to titlebar (Hello
World!).

| Note: Properties that are left blank are not shown in the XML code.

Using the Property Editor

You can also specify the property values using the Property Editor. In this case, you can access
detailed help information on each property.

~ To use the Property Editor

1  Select the control in the layout tree for which you need help, for example, the titlebar (Hello
World!) node.

_

- |page
+ T titlebar (Hello Warld!]
+ ] header
+ | pagebaody
[_| statushar

‘ |+l

=3l

=
-
=

2 From the Edit tab of the Layout Painter, choose Property Editor.

The following dialog appears.
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3 TITLEBAR

Basic
Basic properties for this control,

-- Web Page Di... [E3

name Hello Warld!
textid

withclose

align

image

helpid

titlestyla

pizelheight

straighttext

closetitle

£

£

hd

Click onto a name of an property to see a help text

Basic
Binding

Eack

Mext

Finish || Cancel

The properties of the control are listed.

Choose the Finish button to close the dialog.

Any changes you have applied in the dialog will be saved.

Click on the name of a property to display detailed information on this property. This inform-
ation is shown below the list of properties.
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Specifying a Name and Method for the Button

You will now specify the string "Say Hello" which is to appear on the button. And you will specify
the name of the method that is to be invoked when the user chooses this button.

~ To specify the name and the method for the button

1  Inthelayout tree, open the header node.

. Note: By clicking the icon of a node, you hide or expand the node’s subnodes.

You can now see the entry for the button with the default name "Save".

2 Select the node button (Save).
3 Specify the following properties:

Property |Value

name |Say Hello

method|sayHello

The method needs to be programmed in the adapter class. This will be explained later in this
tutorial.

Adding the Input and Output Areas

The input and output areas in this tutorial are created using Row Area controls. These controls
can be found in the Container section of the controls palette.

Each row area will contain an Independent Row control which in turn contains a Label and a
Field control. These controls can be found in the Controls section of the controls palette.

For adding controls to your layout, you drag them from the controls palette onto the corresponding
tree node in the layout tree. This is explained below.

~ To create the input area

1 Open the Container section of the controls palette.

When you move the mouse over a control, a tool tip appears which also displays the control
name which will be used in the XML layout. For example:
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Page

Container

ez Independent Row el

:::: Table Row

#+=+ Harizontal Distance

i Vertical Distance

Foow Area

5 Collpow Area (ROWAREA)
% Row Area With Hea

wH Area Header

Area Bady

2 Drag the Row Area control from the controls palette onto the pagebody node in the layout
tree.

The row area is added as a subnode of the pagebody node. The new subnode is automatically
selected so that you can maintain the properties of the row area directly in the properties area.

3  Specify the following property:

Property | Value

name |Input Area

4  Drag the Independent Row control from the controls palette onto the rowarea (Input Area)
node in the layout tree.

When you drop information into the tree, the system will sometimes respond by offering a
context menu with certain options about where to place the control. In this case, the following
context menu appears.

-] pagebaody

= Add as Subnode
[ ]sta

f+ Add as preceding Mode
+ Add as subsequent Node

| Note: When you move the mouse outside the context menu, the context menu disap-
pears. The control is not inserted in this case.

5 Choose the Add as Subnode command.
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The control is now inserted below the rowarea (Input Area) node. The new node is shown
as itr.

6  Open the Controls section of the controls palette.

7 Drag the Label control from the controls palette onto the itr node you have just inserted and
specity the following properties:

Property | Value

name |Your Name

width |100

8  Drag the Field control from the controls palette onto the itr node you have just inserted.

A context menu appears and you have to specify where to place the control.

-] pagebaody
- rowarea (Input Area)l
&2 Add as first Subnode

_ Bz Add as last Subnode
| stati=oan

9  From the context menu, choose the Add as last Subnode command.

10 Specity the following properties for the field:

Property Value

valueprop|name

width 200

| Note: Aslong as the adapter class is not defined, the field is dimmed and it is not pos-

sible to enter information in this field. The adapter class will be defined later in this
tutorial.

~ To create the output area

= Create the output area in the same way as the input area (add it as the last subnode of the
pagebody node), with the following exceptions:

Row Area
Specify a different value for the following property:
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Property | Value

name |Output Area

Label
Specity a different value for the following property:

Property | Value

name |Result

Field
Specity different values for the following properties:

Property Value

valueprop |result

displayonly|true

| Note: Todisplay the displayonly property, choose the Appearance tab at the bottom

of the properties area. You can then select the required value from a drop-down
list box.

Adding the Image

You will now add the image which is to be shown above the input area. To do so, you will use
the Icon control which can be found in the Controls section of the controls palette.

| Note: The image is provided in Application Designer's /cisdemos/images directory.

- To add the image

1  Drag the Icon control from the controls palette onto the pagebody node in the layout tree.

The icon is added as the last subnode of the pagebody node. It is automatically placed into
an itr (independent row) node.

2 Specify the following property for the icon:
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Property | Value

image |../cisdemos/images/hello.gif

3 Select the itr node containing the icon and choose the following button below the layout tree:
T

The selected node is now moved up so that it appears as the first subnode of the pagebody
node.

4  Specify the following property for the itr node:

Property Value

takefullwidth|true

Adding a Horizontal Distance

When you preview the layout, you will see that the image you have just added appears centered.

You will now move the image to the right side of the page. To do so, you will use the Horizontal
Distance control which can be found in both the Controls section and the Container section of
the controls palette.

> To add the horizontal distance

1  Drag the Horizontal Distance control from the controls palette onto the itr node containing
the icon.

2 From the resulting context menu, choose the Add as first Subnode command.

The node hdist is inserted into the tree.

3  Specify the following property:

Property | Value

width [100%
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Adding an Instructional Text

You will now enter a text which is to appear below the output area and which tells the user what
to do.

To do so, you will once again use the Independent Row control into which you will insert a Label
control.

. Note: The Independent Row control can be found in both the Controls section and the
Container section of the controls palette.

~ To add the independent row with the label
1  Drag the Independent Row control from the controls palette onto the pagebody node in the
layout tree.

2 From the resulting context menu, choose the Add as last Subnode command.

The node itr is inserted into the tree.

3 Drag the Label control from the controls palette onto the itr node you have just created.

4  Specify the following properties for the label:

Property Value

name Input your name and press the 'Say Hello' button.

asplaintext|true

Note: Go to the Appearance tab to display the property asplaintext.

Adding a Vertical Distance

When you preview the layout, you will see that the text you have just added appears directly below
the output area. You will now move the text 100 pixels to the bottom.

To do so, you will use the Vertical Distance control which can be found in both the Controls
section and the Container section of the controls palette.

> To add the vertical distance

1  Drag the Vertical Distance control from the controls palette onto the itr node containing the
label.
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2 From the resulting context menu, choose the Add as preceding Node command.

The node vdist is inserted into the tree.

3  Specify the following property:

Properties | Value

height |100

Saving Your Layout

If you have not already done so, you should now save your layout.

When you save a layout for the first time, an HTML file is generated (in addition to the XML file)
which is placed into the root directory of your application project. This HTML file is updated each
time you save the layout.

~ To save the layout

= Choose the following button which is shown at the top of the Layout Painter.
=

You can now proceed with the next exercise: Setting Up Your Environment.
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26 Setting Up Your Environment

The recommendation is to use Natural ONE. Create a Java Project and enable it for AjaxDeveloper.
For more information see the NaturalONE documentation.

You can now proceed with the next exercise: Writing the Adapter Code.
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Defining the Class Name

As a last step of your layout definition, you will now define the name of the class which is the lo-
gical counterpart of your page.

> To define the class name

1  Inthelayout tree, select the top node page.

You can see the default entry "DummyAdapter" for the model property.
2 Specify the following property:

Properties |Value

model  |HelloWorldAdapter

Generating the Code

You use the Code Assistant, which is part of the Layout Painter, to generate code for the referenced
properties and methods.

~ To generate code

1 From the Tools tab of the Layout Painter, choose Code Assistant.

The following is shown in the preview area:
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Binding Adapter Code ps
BRI BBRCE T || import com.softwareag.cis.server.Adapte « |
@ name @ savHello
@ result /f This class is a generated one.

public class HellowWorldadapter
extends Adapter
{
===/

/== initialisation - called when creating
public void initl)

{

4 | 21~ 4 2=l }

Generate Code

/== start of data transfer =/
Generated Code public void reactOnDataTransferstart]
{
super.reactOnDataTransferStart();
} pu—

/== end of data transfer =/
public void reactOnDataTransferEnd()

{
super.reactOnDataTransferEnd();
T
~Tab,||[-+Tab Take.Lver /== start of data collection =/
<| [ -

The properties and methods which cannot be found in the adapter code are indicated by red
dots.

Select the property name.
Choose the Generate Code button.

The generated code appears below this button.

Select the position in the adapter code at which you want to insert the code.

Choose the Take Over button to insert the code at the selected position.

The color of the dot changes from red to green. This indicates that the property's get and set
methods are now available in the adapter code.

Repeat the above steps for the result property and the sayHel10o method.

When you have finished all required steps, the page should look as follows:
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Binding Adapter Code pXs
BRI | AR || import com.softwareag.cis.server.Adapte 4|
) name 0 sayHello
0 result /f This class is a generated one.

public class HelloWorldAdapter
extends Adapter
{
===/

/f property >name<

String m_name; —
public String getMame() { return m_na
1] | »] |J JJ public void setMame(String value) { m_

Generate Code

[ property =result<
Generated Code String m_result;

| public String getResult() { return m_re
public void setResult{String value) £ m

public void sayHellol)

{
if (m_name == null [| m_name.trim(
{
this.outputMessage("E", "Please ¢
- Taby||[-+Tab Take Owver return:

4 | 2l

7 Save your changes and close the Code Assistant.

Programming the Method

Now that the framework for the sayHe110 method has been generated in the adapter code, you
have to program the method itself.

~ To program the method

1 Go to your development environment for Java.

2 Open the file HelloWorld Adapter.java which is located in the project directory /cisyourfirstpro-
ject/src.

3  Add the line which is indicated in bold:
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/** */

public void sayHello()
{

// TODO Auto-generated method stub
m_result = "Hello World, " + m_name + "!";
t

4  Save your changes.

Testing the Completed Application

You will now check whether your application provides the desired result.

~ To test the application

1  Go back to your layout in the Layout Painter.
2 Choose the following button which is shown at the top of the Layout Painter.

€l

3  Enter your name and choose the Say Hello button.

The page should perform correctly now, and successfully “talk” to the adapter you have just

created:
Input Area i
Your Mame Jo
Output Area i
Result Hello, Jo |
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Viewing the Page Outside the Layout Painter

The generated HTML file helloworld.html (which is updated each time you save your layout) can
be found within the root of your application project, that is in <installdir>/tomcat/webapps/cis/cisy-
ourfirstproject.

This HTML page has some prerequisites concerning the browser workplace in which it is running.
Therefore, it is per se not usable as a directly accessible page but needs to be embedded into a
frame providing a defined set of functions.

For viewing the page directly, enter the following URL inside your browser:
http://Tocalhost:51000/cis/serviet/StartCISPage?PAGEURL=/cisyourfirstproject/helloworld.htm]
If the page is not displayed, check the following:

" URLs are case-sensitive. Double-check your input.

® Check whether the file helloworld.html is available in the directory cisyourfirstproject.

Inside the URL, a servlet StartCISPage is invoked. As parameter PAGEURL, a certain value is passed:
this value is built from the application project name and the page name. Calling the servlet is the
generic way of opening pages which are created with Application Designer directly inside the
browser.

You have now completed this tutorial. See the remaining section of these First Steps for some
background information.
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If you Change the Adapter

You can now add more functions to your “Hello World!” application by yourself. This means that
you will both work with the layout description inside the Layout Painter as well as change the
code of the adapter.

Changing the adapter's code requires that you replace your existing class files in the <installdir>/tom-
cat/webapps/cis/cisyourfirstproject/appclasses/classes directory by new ones. What does this mean for
the runtime environment? The runtime does not see these recompiled classes because it already
loaded the existing classes. So there is no difference how the application performs by default.

However, you can explicitly force the server to reload all application classes and to use the newest
class version. The server is clever enough to keep old classes for existing sessions, which means
that users who are already logged on will not be disturbed. But new sessions will get the newest
classes.

The task to update the classes is directly triggered from the Layout Painter by choosing the save
button. This tells the runtime to use new classes for new sessions. Since the preview area always
opens a new session, it will be up-to-date whenever you choose the preview button.

Therefore, you can develop continuously, without restarting the GUI-server Tomcat environment.
For fast readers:

The class loader management mentioned above is designed to be used at design time. At runtime,
especially if running in non-Tomcat environments, you should use the application server's web
class loader to load the adapter classes. Details are provided in other sections of the Application
Designer documentation.

Name Binding between Controls and Adapter

Which are the critical parts when building the “Hello World!” application?

® The PAGE control in the layout points to the class name of the adapter (property modeTl).

® The FIELD control in the layout points to the property name of the adapter (property valueprop).

® The BUTTON control in the layout points to the method sayHel10() of the adapter (property
method).

There is a name binding between the layout definition and its corresponding adapter. This is the
simple and effective approach of the Application Designer's development process: The adapter
represents a logical abstraction of what the page displays. All layout definitions are kept in the
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page - all the logic is kept in the adapter. (Or better: behind the adapter. The adapter itself should
only be a facade to the “real” application logic.)

Data Exchange at Runtime

What happens at runtime?

® The browser accesses (within the preview area of the Layout Painter) the intelligent HTML page
generated from the XML layout description. The HTML page is loaded. Depending on the settings
of your browser, the HTML page is picked from the page buffer of the browser after the first
access.

® The page is loaded and JavaScript statements are executed to send a command to the server,
requesting the data content of the page.

® The server's session management finds out that a new instance of the adapter class has to be
created. It calls the default constructor - without any parameters - of the adapter class and re-
gisters it within its session management.

® The server calls all get methods of the adapter and collects the results in a streamed string. The
string is sent back as a response to the browser.

® The page inside the browser receives the response and distributes the new content to the controls.
The controls are updated using JavaScript statements working with the DOM interface.

® The user provides some input, for example, enters the name. The content change is registered
inside the page.

® The user does something which causes a flush of the changes (for example, the user chooses a
button). Therefore, all registered data changes are packaged as a streamed string and are sent
to the server including the information that a method has to be called.

® The server receives the request and finds by its session management the corresponding adapter
object. First, it pushes all data changes using the set methods into the adapter class and calls
the method.

® The method changes the data inside the adapter.

® The server calls all get methods of the adapter and collects the result into a streamed string.
The string is sent back as a response to the browser.

® And so forth.
With a standard HTTP connection, only the changed content of the screen is passed when operating

on one page. The layout is kept stable in the browser. Consequently, there is no flickering of the
page due to page reloading.

All steps described in the list above are done completely transparent to your adapter; i.e. you do
not have to cope with session management, stream parsing, error management, building up HTML
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on the server, etc. You just have to provide an intelligent HTML page by defining it in the Layout
Painter and an adapter class.

Files and their Locations

Have alook at the files created for your “Hello World!” application and take notice of the directory
in which they are located.

All files are located in the directory <installdir>/tomcat/webapps/cis/cisyourfirstproject. The /cis
directory is the directory of the web application instance. The /cisyourfirstproject directory is the
directory that has been created for your new project

® The XML layout definition is kept in the /xml directory.

® The generated HTML page is kept directly in the project directory. There are also some other
files inside this directory that start with "ZZZZ". These files are temporary files used when
previewing pages inside the Layout Painter.

® The Java class files are kept in the directory /appclasses/classes. There is also a directory /app-
classes/lib where you can find jar files to be imported into your application.

* In the directory /accesspath, “access restriction” files are generated. If you view these files inside
anormal text editor (such as Notepad), you see that one file is maintained for each page; it holds
the information about which properties are accessed by the page.

The directory locations described in this section are the default locations.

Application Project Management

Use the project "cisyourfirstproject” only for your first steps. For real development, create your
own projects. Working inside your own projects, you can be sure that your project files will never
be touched by any Application Designer updates. Therefore, patches or enhancements to Applic-
ation Designer can be installed by just copying them over the existing Application Designer install-
ation.

Keep all your files inside the project directory during the development cycle. Even if this might
work correctly: for example, do not put jar files into the server (Tomcat) directories, but place them
into the corresponding /appclasses/lib directory of your project.

There are some rare cases in which you have to position jar files explicitly inside the Tomcat envir-
onment: for example, if classes of a jar file access native libraries (such as DLLs) by the NI interface.
They can only be loaded once by the class loader. Because both Tomcat and Application Designer
have class loaders which may load a class multiple times, you have to position these classes, for
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example, into the /tomcat/lib directory. However, these are the exceptions. Do not put any classes
outside of the Application Designer project directories unless there is a reason for it.
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